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1�Introduction

Welcome to the ICM-Browser and ActiveICM manual. ICM-Browser provides a
biologist or a chemist with direct access to the treasures of structural
biology and protein families. It reads a variety of file formats
directly from the database web-sites including: PDB, chemical, electron
density maps, sequence and alignment files. ICM-Browser provides a rich
professional molecular graphics environment with powerful
representations of proteins, DNA and RNA, and multiple sequence
alignments.

With the free ActiveICM plugin you can save fully interactive 3D files
to display on the web or in Windows PowerPoint. You can also add and
optimize hyrogens to PDB files, display hydrogen bonds, and display
transparent ligand binding pocket property surfaces as well as other
molecule sufaces.

Features
Please visit our product web pages for a full description of all the
features in ICM-Browser and ActiveICM .

Download
Please follow the links below to download the software.

Getting Started: Download and Install ICM-Browser
and ActiveICM.

Download ICM-Browser Distribution. Download

Install ICM-Browser Instructions. Windows Linux
Mac

Download ActiveICM Distribution. Download

Install ActiveICM. Windows Linux
Mac

1�Introduction 3
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2�Help Videos on YouTube

You can view webinars and how-to videos on many of the functions within
ICM on YouTube.

Link to our YouTube Channel.• 
Link to our Webinar Archives on YouTube.• 

2�Help Videos on YouTube 5
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3�Reference Guide

Chapter Contents:

ICM-Browser Reference Guide

ActiveICM Reference Guide - Create 3D Molecular Documents for the Web
and PowerPoint

Menu and Tab Reference Guide:

Menu Option Guide

Tab Guide

3.1�Graphics Reference Guide

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Chemist | ICM-Pro

For instructions on how to use ICM-Browser to make fully-interactive
3D slides and publish them in PowerPoint and the web please see the
ActiveICM User Guide. ActiveICM is a free plugin for Windows
PowerPoint and web browsers. Other related tutorials include:

Graphical Display: Molecule Representation, Coloring, Labeling
and Annotation

• 

Graphical Selections Tutorial• 
Creating Fully Interactive Slides for PowerPoint and the Web
Tutorial

• 

3.1.1�Download and Install ICM-Browser

Getting Started: Download and Install
ICM-Browser and ActiveICM.

Download ICM-Browser Distribution. Download video

Install ICM-Browser Instructions. Windows Linux
Mac

Download ActiveICM Distribution. Download video

Install ActiveICM. Windows Linux
Mac

3.1.2�How to use the Graphical Display

’; winRef.document.write(str); }

How to use the Graphical Display

How to search the PDB. HTML GUI
Manual video

3�Reference Guide 7



How to Move a Structure in the Graphical
Display.

HTML GUI
Manual video

How to use the Graphics window controls. HTML GUI
Manual

How to use the ICM Workspace Panel HTML GUI
Manual video

How to Display a Molecule. HTML GUI
Manual video

How to Change Protein Representation. HTML GUI
Manual video

How to Change Ribbon Representation. HTML GUI
Manual video

How to color wire or xstick carbon atoms. HTML GUI
Manual video

How to Display the Residues Surrounding the
Ligand Binding Pocket.

HTML GUI
Manual video

How to remove chain breaks (dotted lines). HTML GUI
Manual video

How to Color. HTML GUI
Manual video

How to Change the Color of Molecule
Representations.

HTML GUI
Manual video

How to Change the Background Color. HTML GUI
Manual video

How to Display a Binding Pocket Surface HTML GUI
Manual video

How to (Un)Display Hydrogens. HTML GUI
Manual video

How to Save an ICM Object. HTML GUI
Manual video

How to Save an ICM Project File. HTML GUI
Manual video

How to Drag and Drop. HTML GUI
Manual

How to: Right Click Options. HTML GUI
Manual

How to Move Windows. HTML GUI
Manual video

How to Arrange Windows HTML GUI
Manual video
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3.1.3�How to make Graphical Selections

How to Make Selections. HTML GUI Manual

How to Select an Object HTML GUI Manual video

How to Select a Molecule HTML GUI Manual video

How to Select Residues HTML GUI Manual video

How to Select Atoms HTML GUI Manual video

How to Make a Spherical Selection. HTML GUI Manual video

How to Invert a Selection. HTML GUI Manual video

How to Remove a Selection. HTML GUI Manual video

How to Change the Selection Level and Mode. HTML GUI Manual video

How to Check What is Selected. HTML GUI Manual

3.1.4�How to Convert Proteins, Display Hydrogens
and Ligand Binding Pocket.

Convert Protein, Display Hydrogens and Ligand
Binding Pocket.

How to Convert a PDB Structure into an ICM
Object.

HTML GUI
Manual video

How to Display Ligand Binding Pocket. HTML GUI
Manual video

How to Display Hydrogen Bonds. HTML GUI
Manual video

3.1.5�How to change Graphics Effects

How to change Graphics Effects

How to display the FOG effect. HTML GUI Manual video

How to display side-by-side stereo. HTML GUI Manual

How to display Anaglyph stereo. HTML GUI Manual

How to toggle full screen mode. HTML GUI Manual video

How to adjust perspective. HTML GUI Manual

How to change the lighting. HTML GUI Manual video

How to display sketch accents. HTML GUI Manual video

3.1.3�How to make Graphical Selections 9



How to display elegant ribbon and ligand
sketch. HTML GUI Manual video

3.1.6�How to add Labels and Annotations

How to add Labels and Annotations

How to Label Residues. HTML GUI Manual video

How to Label Atoms. HTML GUI Manual video

How to Label Variables. HTML GUI Manual video

How to Display and Undisplay Sites. HTML GUI Manual

How to Make and Display Sites
(Annotations). HTML GUI Manual

How to Make and Display 2D and 3D Labels. HTML GUI Manual video

3.1.7�How to Make High Quality Publication
Images

How to Make High Quality Publication Images

How to Toggle High Quality Display HTML GUI Manual video

How to Toggle Antialiasing. HTML GUI Manual video

How to Copy Image to ClipBoard HTML GUI Manual video

How to Write an Image. HTML GUI Manual video

How to Use the Advanced Write Image
Options. HTML GUI Manual video

How to Add an Image to the ICM Photo Album. HTML GUI Manual video

3.1.8�How to Superimpose Protein Structures.

How to Superimpose Protein Structures.

How to Superimpose Two or More Protein
Structures. HTML GUI Manual video

3.1.9�How to Measure Distances and Angles.

How to Measure Distances and Angles.

How to Measure Distances Between Two Atoms. HTML GUI
Manual video

How to Measure Distances From One Atom to
Many.

HTML GUI
Manual video
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How to Show Corresponding Distances in Two
Objects.

HTML GUI
Manual video

How to Display the Ruler Bar. HTML GUI
Manual video

3.2�ActiveICM Reference Guide - Create
3D Molecular Documents for the Web and
PowerPoint

This guide is focused on how to make fully interactive 3D documents
for Windows PowerPoint and the Web. For more information on the other
features in ICM-Browser please see the ICM-Browser User Guide.

Creating 3D Documents Is Straightforward
Creating fully interactive 3D documents for PowerPoint, the web, and
standalone browser is straightforward.

Download ICM-Browser and the ActiveICM plugin. They are completely
free! [video]

1. 

Open the ICM-Browser and make a series of animated
fully-interactive slides showing different colored and rendered
views of your molecules. [video]

2. 

Add hyperlinked HTML text to annotate and link to your slides.
[video]

3. 

Save your file in ICM-Browser and then insert into PowerPoint or
the web using the ActiveICM plugin. You can also share your
documents in the standalone ICM-Browser. [video - powerpoint]
[video -web browser]

4. 

’; winRef.document.write(str); }

3.2.1�Getting Started

Getting Started: Download and Install
ICM-Browser and ActiveICM.

Download ICM-Browser Distribution. Download video

Install ICM-Browser Instructions. Windows Linux
Mac

Download ActiveICM Distribution. Download video

Install ActiveICM. Windows Linux
Mac

3.2.2�How to Create a Series of
Fully-Interactive 3D Slides.

Creating Slides How to Create a Series of
Fully-Interactive 3D Slides. video

How to Make Fully Interactive 3D Slides HTML GUI
Manual

3.1.9�How to Measure Distances and Angles. 11



How to Animate Slides HTML GUI
Manual

How to View and Navigate Slides in the ICM-Browser. HTML GUI
Manual

How to Edit Slides. HTML GUI
Manual

How to Add Smooth Blending and Transition Effects
Between Slides.

HTML GUI
Manual

3.2.3�How to Create Molecular Documents

How to Create Molecular Documents: Linking Slides to
HTML Text. video

How to Create an HTML Document. HTML GUI
Manual

How to Edit an HTML Document. HTML GUI
Manual

How to Make a Hyperlink Between HTML Text and a
Slide.

HTML GUI
Manual

3.2.4�How to Display Molecular Documents in
PowerPoint

How to Display Molecular Documents in PowerPoint video

How to Embed in Microsoft PowerPoint 2003 HTML GUI
Manual

How to Embed in Microsoft PowerPoint 2007 HTML GUI
Manual

How to Use ActiveICM in PowerPoint HTML GUI
Manual

How to Change ActiveICM Component Properties in
PowerPoint

HTML GUI
Manual

Advanced use of ActiveICM: Macros to direct
visualisation changes.

HTML GUI
Manual

3.2.5�How to Display Molecular Documents on the
Web

How to Display Molecular Documents in Web Browsers video

How to Display Molecular Documents in Web Browsers HTML GUI Manual

12 3.2.2�How to Create a Series ofFully-Interactive 3D Slides.



3.3�Menu Option Guide

Note: Click Next (top right hand corner) to navigate through this
chapter. Headings are listed on the left hand side (web version) or
by clicking the Contents button on the left-hand-side of the help
window in the graphical user interface.

Here we describe all the options in the drop down graphical user
interface menus.

3.3.1�File Menu

3.3.1.1�New

This option allows you to create new peptides, dna, sequences etc... and
is described in the Create New Objects chapter.

3.3.1.2�New ICM Session

File/New ICM Session

This option allows you to generate a new clear ICM session or clone the
current one.

3.3.1.3�Open

File/Open

This option is described in the Open and Read chapter.

3.3.1.4�Open with Password

File/Open with Password

This option is described in the Open and Read chapter.

3.3.1.5�Extract from ICB

File/Extract from ICB

This option is described in the Open and Read chapter.

3.3.1.6�Load

Options contained within the menu File/Load

3.3�Menu Option Guide 13



PDB - read PDB from FTP, http, and local PDB

From Multiple Object File - A multiple object file will have a file
extension *.ob and you can select which member of the multiple object is
displayed.

PFam Alignment - PFam is a collection of multiple sequence alignments -
enter FASTA ID

SwissProt - Download SwissProt sequence.

All Images from Dir - Read into ICM multiple image files png or jpg.

Electron Density Map - Download electron density map from Uppsala
electron density server http://eds.bmc.uu.se/eds/

3D Mesh in KMZ or COLLADA Format from Google - see
http://sketchup.google.com/3dwarehouse/ to download KMZ or COLLADA.

3.3.1.7�Save Project

This is described in the Save File chapter.

3.3.1.8�Save Project As

This is described in the Save File chapter.

3.3.1.9�Save Project Compatible with ICM 3_5

File/Save Project Compatible with ICM 3_5

Use this option to save a version of your ICM project compatible with an
older version of ICM. Version 3.5 or older. If you have an ICM license
you can update your version of ICM by visiting our support site at
www.molsft.com/support

3.3.1.10�Save with Password

To save a project which is protected by a password:

File/Save with Password• 
Enter a file name or browse for a previously saved project.• 
Enter a password• 
Determine whether you want the file to be Fully Protected, read
only or Read Only and Allow Comments .

• 

3.3.1.11�Export as ActiveICM Html

To embed in a web browser.

Download ActiveICM from here
http://www.molsoft.com/getbrowser.cgi?product=activeicm&act=list
(it is free!).

1. 

Create an HTML page in ICM (File/New/Html).2. 
Add a series of slides.3. 
File/Export As ActiveICM Html..4. 

14 3.3.1�File Menu



3.3.1.12�Close Project

To close a project:

File/Close Project

3.3.1.13�Quick Image

See the High Quality Publication Image chapter.

3.3.1.14�Write Image

See the High Quality Publication Image chapter.

3.3.1.15�Preferences

Preferences are described in the Preferences chapter.

3.3.1.16�Recent Files

Recently viewed projects and files can be easily downloaded from the
"Recent Files" option. To access this:

Select File/Recent Files.• 
Select the desired project by clicking on it once.• 

3.3.1.17�Recent PDB Codes

Quickly retrieve and display PDB structures that have recently been
viewed.

Select File/Recent PDB Codes• 
Select desired PDB code by clicking on it once and it will be
loaded into the graphical display.

• 

3.3.1.18�Quit

Need to close down ICM - no problem. You do one of the following:

Select File/Quit. ICM will quit without saving files.1. 
Save and Click X at the upper right corner of the ICM window.2. 
Type quit in the terminal window.3. 

NOTE: You may want to save the icm session as an ICM Project file
before quiting.

3.3.2�Edit Menu

3.3.2.1�Delete

This option will delete anything that is selected.

3.3.2.2�Delete All

This option will delete everything e.g. sequences, structures, tables
... Use with care!
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3.3.2.3�Select All

This option will select everything e.g. sequences, structures, tables...

3.3.2.4�Search in Workspace

This option allow you to search for a particular text in the workspace

3.3.2.5�Selection

This option allows you to make a precise selection either by neighbors
or specifying a particular atom or neighbor. Click on the tabs to jump
between selection levels.

3.3.2.6�Invert Selection

This option will select everything that is not currently selected.

3.3.2.7�Clear Selection

This option will remove all selections. For more information on
selections see the Making Selections Chapter.

3.3.2.8�Neighbor Selection

This option will allow you to select neighboring atoms. For more
information see the Select Neighbors section in the Selections Chapter.

3.3.2.9�Undo

Due to the complexities of working in an internal coordinates
environment not everything can be undone or redone. Certain things like
coloring and representations can be undone or redone.

3.3.2.10�Redo

Due to the complexities of working in an internal coordinates
environment not everything can be undone or redone. Certain things like
coloring and representations can be undone or redone.

3.3.2.11�Restore Recent Backup

ICM periodically makes a backup of your ICM project. If for whatever
reason you lose an ICM session and you want to load the backup for the
file use:

Edit/Restore Recent Backup

3.3.2.12�PDB Search

See PDB Search Tab

3.3.2.13�PDB Search by Field

See PDB Search Tab

16 3.3.2�Edit Menu



3.3.2.14�PDB Search by Identity

See PDB Search Tab

3.3.2.15�PDB Search by Homology

See PDB Search Tab

3.3.2.16�PDB Search with External Seqeuence

See PDB Search Tab

3.3.2.17�Ligand Tools

See the ligand editor section of the manual.

3.3.2.18�Ligand Editor Preferences

See the ligand editor section of the manual.

3.3.3�View Menu
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3.3.3.1�Undisplay All

To undisplay everything currently displayed in the graphical display

View/Undisplay All• 

Note For more details on displaying structures please see the GUI
Overview chapter.

3.3.3.2�Clear Display & Planes

To clear the display and planes

View/Clear Display and Planes• 

NOTE: For more details on planes please see the sections on clipping
tools and mesh clipping.

3.3.3.3�Selection Level

There are four levels of selection - atom, residue, molecule and object.
For more details on selections please see the Making Selections section.

3.3.3.4�Selection Mode

There are four different ways to make selections - new, add, remove and
toggle. For more details on selections please see the Making Selections
section.

3.3.3.5�Fog

Fog Toggle(Ctrl + D) : this feature creates a fog-like environment for
your object, so that the part of your structure that is closer appears
clear and the distant parts are faded as if they are in fog. The
clipping planes control the point at which the fog begins.

View/Fog• 

3.3.3.6�Side-by-Side Stereo

Side-by-side stereo toggle(Ctrl + S) : this feature allows you to view
your structure in 3D form without any 3D goggles.

View/Side-by-Side Stereo• 

3.3.3.7�Hardware Stereo

Hardware stereo toggle(Alt + S) - if you have 3D goggles and you wish to
view your structure in 3D form, this feature will allow you to do so.

View/Hardware Stereo• 

3.3.3.8�Full Screen

Full screen toggleAlt_F - this makes your graphical display fill the
entire screen. If you wish to exit this mode, press escape.
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View/Full Screen• 

3.3.3.9�Perspective

Toggle perspective Ctrl_P this will add perspective to your structure,
enhancing depth in the graphical display.

View/Perspective• 

3.3.3.10�Full Scene Antialias

Anti-aliasing is the technique of minimizing the distortion artifacts
known as aliasing when representing a high-resolution signal at a lower
resolution. Always use this option before making high resolution images.

View/Full Scene Antialias• 

3.3.3.11�High Quality

Toggle High Quality: this option will give your ICM object better
resolution and higher quality. The change in quality is most visible at
a high magnification. However, if your object is very large, this
feature could slow down your program.

Always use this option before making high resolution images.

View/High Quality• 

3.3.3.12�Easy Rotate

Toggle easy rotation: this feature is necessary if your structure is
very large or perhaps your computer cannot quickly rotate it. It will
prevent your structure from fully loading each time you rotate it,
therefore speeding up the process.

View/Easy Rotate• 

3.3.3.13�Sketch Accents

To make images as shown below use:

View/Sketch Accents• 

See Graphics Effects chapter.

3.3.3.14�Animate View

This tool is described in more detail in the Molecular Animations and
Transitions section.

3.3.3.15�Drag Res Labels

To change the location of your residue label:

Select View/Drag res labels.• 
If your mouse has a middle mouse button, then click on handle (as
shown) of the label you wish to move, and drag it to your desired
area.

• 
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If your mouse does not have a middle mouse button, then click on
the Translation icon on the toolbar, and click on the handle (as
shown) of the label you wish to move, and drag it to your desired
area.

• 

The +/- buttons on the side of the Residue and Atom buttons will shift
the label. There are also other residue label move options available
when you click and hold the residue label button. These options include
Shift to Sidechain Tips, Shift to Calphas, and Restore Positions

3.3.3.16�Antialias Lines

Use this option to activate antialias lines. It is recommended to leave
this option selected.

View/Antialias Lines• 

3.3.3.17�Color Background

To change the background color

View/Color Background• 
Select a color from the panel and press OK.• 

This option is also in the more convenient display tab.

3.3.3.18�Save Viewpoint

It is possible to store a current view using the button shown below.

Click on the button and the current view will be stored so that you can
view it later. A data entry box will be displayed asking you to name the
view. All stored views can be found in the ICM workspace as shown below.

Double click on the view in the ICM Workspace to display it.• 

A number of view display options are available by right clicking on the
view in the ICM workspace as shown below.
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The option in the right click menu called "set view smooth" returns to
the view slowly showing the trajectory between the original view and the
current one.

3.3.3.19�Center

To center on an object displayed in the graphical display

Make a selection on the region on which you wish to center on.• 
Tools/Center (or use the center button on the right hand-side of
the graphical display).

• 

3.3.3.20�Select by Purple 3D Box

An alternative way to make a make-selection{selection} is to use the
purple 3D box. To do this:

Select the display tab and the purple box button• 
View/ Select by Purple 3D Box• 
The atoms contained within the purple box will be selected.• 

3.3.4�Windows Menu

This menu allows you to choose the windows you wish to display. The
windows which open automatically when you first open GUI are shown in
the Getting Started section. Other windows can be displayed by selecting
the windows menu. For example, if you have loaded a table but cannot see
it in the GUI it may be because the Tables option in the window menu
hasnt been selected.

To add or remove windows from the GUI display select the ’window menu’.
Other windows not included in the default display such as tables and
alignments can be added.
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To return to the default display option select the ’Default layout’
option in the windows menu.

OR

Click the default layout icon.

3.4�Tab Guide

In this section we describe the contents of the tabs in the graphical
user interface.
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3.4.1�Display Tab

The display tab contains tools for a variety of functions including -
structural representations, coloring, labeling and superposition. This
tab is shown below.

3.4.2�Light Tab

The options in this tab are described in the Lighting Section.

3.4.3�Labels Tab

The options in this tab are described in the labels section of this
manual.

3.4.4�PDB Search Tab

Instructions on how to use this tab can be found in the Search PDB
section.

3.4.5�Ligedit Tab

Instructions on how to use the options in this tab can be found in the
How to use the 3D Interactive Ligand Editor section.
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3.4.6�Meshes Tab

Click on the tab button entitled ’meshes’ and three different graphical
display tools are available for you to use. The three displays are
surface, meshes and macroshape and are collectively referred to as
meshes.

The benefits and applications of each display are described in the
section.
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4�Getting Started

Chapter Contents:

The Basics of the Graphical User Interface• 
How to search and Download Protein Structure, Sequences, and
Chemicals

• 

How to create new Objects• 
How to open files• 
How to save files• 
How to Make Selections• 
Changing Preferences• 

4.1�The Basics of the Graphical User
Interface

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro | ICM-Chemist

4.1.1�The Components of the GUI

The Graphical User Interface (GUI) has many components. When you first
use the GUI the default window layout is displayed as shown below.

4.1.2�How to load a PDB Structure

There are three main ways to read in a PDB file.

Using the command line.1. 
Using File/Open button2. 
Using the PDB Search tab3. 

Other PDB search options are described in more detail in the PDB Search
section of this manual.
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4.1.3�How to Move a Structure in the Graphical
Display

Available buttons and options for moving molecules around the graphical
display window. This is described in more detail in the section entitled
Move Buttons.
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How to use the Graphics window controls

In the graphics window you can use various tools described elsewhere but
it is helpful to know the following things:

Picking a tool: the left mouse button will function according to
the selected tool

• 

Popup menus: right click on an atom gives a pop-up menu• 
Selecting in the rotation mode: the right mouse button will select
atoms

• 

Translating in the rotation mode: the middle mouse button will
translate the scene

• 

Zooming and moving clipping planes in the rotation mode: the left,
top and right margins of the graphics window are reserved for
other actions, zoom, z-rotation, and clipping plains,
respectively. That means that even if you are picking atoms, by
pressing control you can still rotate your molecule with the
left-mouse-button.

• 

Rotating in any non-rotation mode: if you press Control in any
mouse mode, e.g. zoom, pick etc., it will temporarily switch to
rotation

• 

Escaping from the connect and continuous movement modes: pressing
Escape helps to get out of certain modes, such as Full Screen,
Continuous rotation or rocking, the Connect mode.

• 

Global rotation in the Connected mode: pressing Shift will
temporarily switch to the global rotation/translation mode.

• 

4.1.4�How to Display Molecules using the ICM
Workspace Panel

The workspace panel (located on the left hand side panel of the gui) is
an important place within the graphical user interface because it
displays which sequences, structures, objects, tables and alignments are
currently loaded into ICM. From the ICM Workspace panel you can make
graphical selections and display and undisplay molecules.
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Once a structure has been loaded into ICM the individual components of
that structure (i.e. amino acids, metal ions, binding sites etc) are
listed in the ICM workspace.

To display every component of the object except for binding sites and
water atoms:

Click on the white box next to the word object at the top of the
ICM workspace. This box will be colored blue once the structure is
displayed

• 

To display the whole structure in wire, ribbon, cpk, skin, surface and
xstick representations:

Right click on the blue box next to the word object. A menu will
be displayed.

• 
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Select which representation you desire for your structure by
clicking on the appropriate word. A check mark indicates the
representation currently displayed. To un-display a particular
representation click on the word again.

• 

In order to clear your graphical display:

Select View/Undisplay All• 

If you only wish to display part of the structure then click in the
boxes further down the tree in the ICM workspace.

To display selected regions of the molecule in wire, ribbon, cpk, skin,
surface and xstick representations:

Right click on the appropriate box in the ICM workspace. A menu
will be displayed and select the representation you would like to
use (e.g. wire, ribbon etc...)

• 

4.1.5�How to Make Selections

Making selections in ICM is an important skill to master (e.g. you may
want to select a binding pocket for docking or a region of a molecule
for coloring). The four levels of selection are:

Atoms1. 
Residues2. 
Molecules3. 
Objects (multiple molecules comprising a PDB entry)4. 

There are several ways of making selection in ICM. The simplest is to
interact directly with the graphics window - right-click, hold and drag
around the area of the screen you want to select. Alternatively, in the
workspace window, expand the tree of molecules and chains until the
relevant protein sequences is displayed. Then left click and drag to
mark residues to form a selection.

See the chapter entitled Making Selections for more information.
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4.1.6�How to Change Protein Representation

To change the representation of the protein, make a selection and then
use the tools in the display tab.

There are 6 main types of representation:

Wire: Wires connecting covalently bound atoms of a molecule. This
representation has no defined thickness as such will not make
shadows. Useful for showing the chemical structure of a small
molecule.

• 

Xstick: Covalent bonds are represented as cylinders whilst atoms
are represented as small spheres.

• 

CPK: Atoms are represented as spheres with their respective van
der Waals radius and coloured according to a standard defined by
Corey, Pauling and Kultun.

• 

Surface: Solvent accessible surface. This is the center of water
sphere as a water probe rolls over the molecule.

• 

Skin: A Connolly molecular surface over the selection. This is a
smooth envelope touching the van der Waals surface of atoms as a
water probe rolls over the molecule.

• 

Ribbons: Cartoon representation of protein and DNA secondary
structure. Protein residues marked as alpha-helices (’H’) are
shown as a flat, helical ribbon, those marked as beta-sheets (’E’)
are shown as a flat ribbon with an arrow-head, and the rest are
shown as a cylindrical "worm". If secondary elements are not
defined everything will be shown as a cylindrical worm. ICM can
automatically assign secondary structure: Tools/3D predict /Assign
Helices and Strands

• 
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4.1.7�How to Color

To change the color of the representation you need to use the buttons in
the display tab.

Changing the colour of a representation works in much the same way as
displaying the representation itself. The selection rationale is the
same followed by clicking on a colour in the palette in the display tab.
It is also possible to colour different representations of the same
selection independently by clicking and holding on the representation
buttons in the display tab.
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4.1.8�How to Display a Binding Pocket Surface

To display the surface of a small molecule ligand or peptide binding
pocket:

Load the PDB of interest.• 
Convert PDB to ICM object. If you do not convert you will not get
the properties of the pocket displayed on the surface.

• 

Right click on the small molecule or peptide in the ICM Workspace
and select Ligand Pocket.

• 
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4.1.9�How to Save an ICM Object

Any ICM object such as a structure, sequence, or alignment, can be saved
for use at a later time.

To save an object:

Right click on the object name in the ICM workspace or ICM
alignment editor and a menu will be displayed.

• 

Click on the Save As... option.• 
Enter the unique name you wish to call your object in the box
labeled File name:

• 

Choose which folder or directory you wish to save your object by
clicking scrolling down in the box labeled Save in:

• 

Choose which file type you would like to save your object as by
scrolling down in the box labeled Save as type . ICM structure
objects should have the file ending yourfilename.ob and alignments
yourfilename.ali

• 

Once the appropriate information has been entered click on the
Save button in the bottom right hand section of the window.

• 

The object is now saved.• 
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4.1.10�How to Save an ICM Project File

All objects contained within an ICM session can be saved in a single
file with the extension .icb. The file can then be read into ICM and the
exact layout of the file will be preserved. To save a project file go to
the File menu and select Save Project.

4.1.11�How to Drag and Drop

NOTE: "Drag and Drop" is a useful way of moving objects and sequences
around the graphical user interface.

Sequences and objects can be moved around the graphical user interface
by dragging and dropping them. All loaded sequences and objects are
always displayed in the workspace panel. Select the desired object or
sequence from the workspace panel by clicking and holding, move the
selection to the desired location and release.

This is a useful application in the graphical user interface. For
example, you may have an alignment displayed and you wish to add another
sequence to the alignment. This can simply be accomplished by dragging a
loaded sequence from the workspace panel into the alignment display
panel. Or, you can quickly view an object by dragging and dropping it
from the workspace panel into the 3D graphics window.

4.1.12�How to: Right Click Options

NOTE: If you right click on any object you will see a new menu of
options related to that object.

The right click mouse option can be used throughout the graphical user
interface. It is a very useful means of opening up a whole new world of
menus and options. Most of these options are described in this book.
However, when using the graphical user interface it is always a good
idea to try right clicking the mouse on an object and seeing which extra
options that are available for you to use.

4.1.13�How to Move Windows

Is your graphical user interface looking a bit messy? Do you have
tables, alignments, plots all over the place? Here we show you how to
arrange everything to make a clearer GUI environment.
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1. Too many windows in your GUI? You can move them around to make
viewing easier.

2. Click and drag on a window title bar to move it.
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3. Drop one window on another one to dock it.

4. You can access each window by clicking on the tabs.
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5. In this example we have the table, alignment, and terminal all in
the same panel

6. There is a quick way to return the windows to their original
location.
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7. You can also move a window to any part of your screen.

NOTE: To return to the default display option select the ’Default
layout’ option in the windows menu.

OR

Click the default layout icon.

OR

Double click on the window header.

4.1.13.1�How to Arrange Windows

Sometimes when using ICM you may have many items displayed such as
structures, alignments and tables. As a default the graphical display is
the largest and centered in the middle of the ICM graphical user
interface. However if you wish to work on an alignment or table you can
place the alignment or table as the main display by clicking on the
buttons shown below. The larger display generally makes it easier to
manipulate the alignment or table. There are ofcourse other ways to
alter the layout such as tier the windows but this option is just a
simple click and can sometimes come in useful.
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4.1.14�How to Make a Picture

There are several ways of taking a picture of the contents of the 3D
graphical display window see the write image section. However the
easiest way is to simply click on the button in the view tools panel
(see image below).

Or select /File/Quick Image

The picture will be automatically saved as a PNG file in the directory
from which you loaded ICM. The default picture name is icm[n].png, where
n is the number of pictures taken in one ICM session. To save in other
picture formats and to change the file name see the write image section.

4.2�How to search and download Protein
Structure, Sequences, and Chemicals

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro | ICM-Chemist

The Search tab allows you to search and download content from the
following databases:

The Protein Databank www.wwpdb.org - search for protein and
chemical

• 

The Pocketome Database http://pocketome.org/• 
BLAST search the NCBI sequence database• 
The UniProt Sequence database http://www.uniprot.org/• 
Search the PDB by ligand code.• 
Search Drug Bank http://www.drugbank.ca/• 
Search PubChem https://pubchem.ncbi.nlm.nih.gov/• 
Search ChEMBL https://www.ebi.ac.uk/chembl/• 
Search SureChEMBL https://www.surechembl.org/search/• 
Search the Crystallography Open Database
http://www.crystallography.net/

• 
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Click on the search tab and then use the drop down menu to identify the
database you would like to search and download from.

4.2.1�Search the PDB

How to Search the Protein Databank and Download

The PDB search tab provides easy access to the PDB database. You can use
keyword searching or type in the PDB code you are interested in. An
asterisk (*) wildcard can be used to list all the pdb files currently
available in the protein databank. Different fields can be searched by
using the drop down arrow as shown below. More advanced PDB search tools
and how to use the PDB search result table are described in the section
entititled Searching the PDB.

Once a search is complete a table of PDB files relating to your search
query will be displayed. To view the PDB file in 3D in the graphical
display double click on a row in the PDBSearchResults table.
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To Search the PDB and Download a Structure:

Click on the search tab and enter a search string or PDB code.• 
A table containing the results will be displayed.• 
Double click on a row to load the PDB file. Read more about PDB
search here.

• 

NOTE: If you have a PDB structure already saved you can read it into
ICM by going to the File Menu and selecting Open. PDB files that have
been viewed previously can be loaded using File/ Recent PDB Codes.

4.2.1.1�How to Search the Protein Databank by Chemical
Substructure
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Step 1: Click on the molecule editor button inside the search tab.
Sketch the substructure you are interested in.

Step 2: A table containing the results will be displayed. Double click
on a row to load the PDB file.
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4.2.1.2�How to Query the PDB by Sequence

There are a number of ways to search the PDB by sequences.

BLAST search the NCBI datase using the option "Sequences from
PDB".

1. 

Search by Sequence Pattern using the option in the Edit menu.2. 
Search by Identity using the option in the Edit menu.3. 
Search by Homology using the option in the Edit menu.4. 

4.2.1.3�How to Query PDB by PDB Field

To query the PDB by field (Author, Compound, PDB Header, Experiment
Type, Resolution or Ligand Code

Select Edit/PDB search by field.• 
Enter the search string or value• 
Click OK and a list of related PDB entries based on your search
will be displayed in the PDBSearchResults table of the graphical
user interface.

• 

4.2.1.4�Load and Display NMR Structures

Use the PDB Search tab to load NMR structures from the PDB. You can use
the drop down button shown below to determine how you want to display
your NMR structure. You can choose to display and download the first NMR
model, all models in the PDB file or all models in the PDB in a stack.
If you choose the stack option the the stack will be stored in the
object as described here.

4.2.1.5�Occupancy Display

You can use the options in the PDB Search tab to control if and how the
partial or zero atom occupancies are displayed. You can choose to circle
or label the poor occupancy atoms.
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>>load-pdb-hyperlinks{pdb search hyperlinks} h4-- Hyperlinks to PDB
Website and UniProt {Hyperlinks to Databases}

In the PDB Search Results Table you will see blue hyperlinks that will
take you directly to the PDB website or Uniprot website.

4.2.1.6�Display PDB Header

To display the PDB Header for a PDB file.

First load a PDB file into ICM (see Search PDB)• 
Double click on the word header in the ICM Workspace.• 

The PDB Header information will be displayed.• 
Click on the blue hyperlinked text to link to external web pages
for additional information if needed.

• 

4.2.1.7�Direct link to PubMed

When you search for a PDB file and load it into ICM you will see an icon
(shown below) next to your protein name in the ICM Workspace. Click the
icon and you will be taken directly to the PubMed primary reference
relating to the structure.

4.2.2�Search Pocketome

The Pocketome (www.pocketome.org) is an encyclopedia of conformational
ensembles of all druggable binding sites that can be identified
experimentally from co-crystal structures in the Protein Data Bank.
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Step 1: Click on the search tab and choose the Pocketome option. Check
a field you would like to search e.g. Protein Name, Family, domain...

Step 2: A table of pocketome hits will be displayed. Browse the results
and double click to load a pocketome entry.
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4.2.3�ChEMBL Search

ChEMBL (https://www.ebi.ac.uk/chembl/) is a manually curated chemical
database of bioactive molecules with drug-like properties. It is
maintained by the European Bioinformatics Institute (EBI), of the
European Molecular Biology Laboratory (EMBL), based at the Wellcome
Trust Genome Campus, Hinxton, UK.

To search and download data from ChEMBL:

Click on the Search tab.• 
Choose ChEMBL from the drop down button.• 
Enter a search string or search by chemical sketch by clicking on
the editor button in the panel.

• 

Select a field to search e.g. Protein Name.• 
Select whether you wish to return just activity data or all data.• 
Click the search button.• 

A table will be displayed as shown below.

The table contains the original activity data without merging or
aggregation. For instance,
Chemical 1, Protein 1, Activity 1
Chemical 1, Protein 1, Activity 2
Chemical 1, Protein 2, Activity 1
Chemical 2, Protein 1, Activity 1

Click on the button Get Best Activity to display the best activity for
each chemical, protein pair. For instance,

Chemical 1, Protein 1, Best(Activity 1, 2, 3, ...)
Chemical 1, Protein 2, Best(Activity 1, 2, 3, ...)
Chemical 2, Protein 1, Best(Activity 1, 2, 3, ...)

Click on the button Get Ligand Summary to display a list of chemicals
with all activities found in ChEMBL. For instance,
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Chemical 1, Protein 1, Activity 1

Protein 1, Activity 2
Protein 2, Activity 1
Protein 3, Activity 1

Chemical 2 Protein 1, Activity 1
Protein 2, Activity 1
Protein 2, Activity 2

4.2.4�Search SureChEMBL

SureChEMBL (https://www.surechembl.org/search/) provides free access to
chemical data extracted from the patent literature. To search
SureChEMBL:

Click on the Search tab.• 
Choose SureChEMBL from the drop down button.• 
Enter a search string or search by chemical sketch by clicking on
the editor button in the panel.

• 

Select a field to search e.g. Protein Name.• 
Select whether you wish to return just activity data or all data.• 
Click the search button.• 

4.2.5�BLAST Search

To BLAST search the NCBI sequence database:

Step 1: Load a sequence into ICM. Select the Search tab and choose the
BLAST option. Drag and drop the sequence into the search field, use the
drop down menu or type the sequence name.
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Step 2: A fully interactive table and plot of sequence conservation
will be displayed. Double click to load a sequence.

4.2.6�Search UniProt
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Step 1: Click on the search tab and select Uniprot from the drop down
menu. Enter the UniProt code. The sequence will be loaded directly into
ICM and you will see it in the ICM workspace.

4.2.7�Search PDB by Ligand Code

To find structures containing a particular ligand in the PDB.

Step 1: Click on the search tab and select Ligand Code from the drop
down menu. Enter the Ligand code and a table of hits will be displayed.

4.2.8�Search Drug Bank

To search Drug Bank ( http://www.drugbank.ca/)
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Step 1: Click on the search tab and select Drug Bank from the drop down
menu. Enter a search string and a table of results will be displayed.
The table contains the original activity data without merging or
aggregation. For instance,
Chemical 1, Protein 1, Activity 1
Chemical 1, Protein 1, Activity 2
Chemical 1, Protein 2, Activity 1
Chemical 2, Protein 1, Activity 1

Click on the button Get Ligand Summary to display a list of chemicals
with all activities found in Drug Bank. The button is located in the
extra panel (click on hammer - top right of table panel). For instance,
Chemical 1, Protein 1, Activity 1

Protein 1, Activity 2
Protein 2, Activity 1
Protein 3, Activity 1

Chemical 2 Protein 1, Activity 1
Protein 2, Activity 1
Protein 2, Activity 2

4.2.9�Search PubChem

To search PubChem (https://pubchem.ncbi.nlm.nih.gov/):
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Click on the search tab and select PubChem from the drop down
menu.

• 

Enter a search string and a table of results will be displayed or
click on the chemical sketch button and sketch a substructure.
When you close the chemical sketch window the smiles string will
be added to the keyword search panel.

• 

Click on the "binocular" button and run the search.• 
A table of hits will be displayed.• 

4.3�Create New Objects

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro | ICM-Chemist

In the File menu there is an option called New. This option can be used
to create new objects of the following types:

Peptide• 
Unusual Peptide• 
Compound• 
DNA and RNA• 
Sequence• 
Script• 
HTML• 
Table• 
Arrow• 
Box• 
Sphere/Ellipsoid• 
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4.4�Open and Read Files

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro | ICM-Chemist

Any file that ICM can understand can be opened by:

Selecting File/Open.• 

A file with an extension .icb is an ICM binary file and can be viewed in
the GUI. A .icb file can contain many objects such as sequences, meshes,
protein objects, alignments, tables etc...

4.4.1�Open with Password

To open a file that is password protected:

File/Open with Password• 

4.4.2�Extract from icb file

An icb file is an icm project file, in some instances you may want to
take objects saved in an icb file and load it in your current ICM
session. This option allows you to view a tabulated list of what a icb
file contains and load individual object files from it.

File/ Extract from ICB.• 
Locate the saved icb file.• 
A table as shown below will be displayed• 
Double-click on any of the entry to extract that object from the
icb file.

• 
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4.5�Saving Files

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro | ICM-Chemist

Anything you have displayed in an ICM graphics session can be
conveniently stored in a single file called an .icb file. To do this:

File/Save Project• 

or

File/Save Project As• 

A .icb file can be password protected by:

File/Save with Password• 
Enter a file name or browse for a previously saved project.• 
Enter a password• 
Determine whether you want the file to be Fully Protected, read
only or Read Only and Allow Comments .

• 

Any object (e.g. protein,table, alignment...) inside the ICM GUI can be
saved by:

Right click on the name of the object in the ICM Workspace.• 
Select "Save As"• 
Choose the file format from the "Save as Type" drop down dialog.• 
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4.6�Making Selections

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro | ICM-Chemist

Note: Click Next (top right hand corner) to navigate through this
chapter. Headings are listed on the left hand side (web version) or
by clicking the Contents button on the left-hand-side of the help
window in the graphical user interface.

There will be many occasions when you will have to make selections. For
example, if you want to display a particular region or molecule
contained within your protein structure or if you want to select
residues around a binding pocket. If you have a molecule displayed in
the graphics window, then selections will be displayed as green crosses.
The selection you have made is also displayed at the top of the ICM
Workspace. It is always a good idea to keep an eye on what is selected
and what isnt.

There are four basic levels of selection

Object (eg a PDB structure or ICM object)1. 
Molecule2. 
Residue3. 
Atom4. 

You can make selections in:

The Graphics Display• 
The ICM Workspace (Selections are highlighted in blue)• 
Tables• 
Sequences• 
Plots• 
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Alignments• 

4.6.1�Graphical Selection Tools

The following buttons can be used to make a selection once a structure
is displayed.

NOTE: All selection tool buttons are colored green. Graphical
selections are represented as green crosses.

4.6.2�Quick Selection

To make a quick selection the following buttons can be used.

To select parts of your structure:

Click on the Rectangular selection icon and click and drag around
the part of the structure you wish to select.

• 

OR

Click on the Lasso selection icon and click and drag your mouse
around the area of the structure you wish to select, forming a
lasso around it.

• 

To pick individual atoms:

Click on the ’pick atom’ button• 
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4.6.3�How to Change the Selection Level and Mode

It is possible to change the level of selection before or during the
building of a selection. The selection level drop-down button can be
used to do this (see image below).

For example, a C-alpha of a residue is selected but one would like to
select all atoms in the residue. You can change the level to Residues.
This selection can then be changed into all atoms of the residue by then
selecting the Atoms level again. Or you can use the Propagate Selection
to all Atoms button (see image below).

Click on the Select objects , Select molecules, Select residues,
or Select atoms icon, depending on which part of the structure you
wish to be highlighted.

• 

It is also important to observe the selection mode that is being used.
There are four modes:

New: new selection replaces everything selected before• 
Add: new selection is added to previous selection(s), if any• 
Remove: previously selection (part or whole of it), if included in
the new selection will be unselected.

• 

Toggle: within the new selection, everything that has been
selected is unselected and everything that hasnï¿‰t been selected,
wilbe selected

• 

4.6.4�How to check what is selected.

All selections are displayed as green crosses in the graphical display
and blue in the ICM Workspace. All green selections are returned to a
variable called as_graph.
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4.6.5�Orange Selection

Sometimes it is necesary to have two different selections. The Orange
selection allows you to do this it is useful for such operations as
superposition and more technical procedures such as designing a protein
loop. The orange selection is returned to a variable called as2_graph.
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4.6.6�Clear Selection

To unselect everything you have previously selected:

Simply click on the Clear Selection button on the selection
toolbar.

• 

OR

Right click and drag away from the displayed structure.• 
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4.6.7�Changing a Selection

Once you have made a selection you may wish to add or remove parts of
the selection. The buttons shown below allow you to accomplish this.

To add or remove from your current selection:

Click on the Selection mode: add or Selection mode: remove icon on
the toolbar.

• 

Click and drag around the part of your structure you wish to add
or remove.

• 

You may also wish to invert your selection in a specific part of the
structure.

The parts that are currently selected will become unselected, and the
unselected parts will become selected.

In order to invert a selection:

Click on the Invert icon on the toolbar.• 
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If you wish to select and unselect certain regions of a selection the
toggle selection button is very useful.

Click on the Toggle selection button.• 
Right click around the selections you wish to select or unselect.• 

NOTE: The selection you have made is recorded at the top of the ICM
workplace. Any selection is stored in the variable as_graph.

4.6.8�Filter Selection

You may want to be very specific about a selection you want to make. For
example you may only want to select protein backbone atoms or you might
want to just select the charged residues.

The button shown below enables you to filter your selection:

Or

Right click on a selection and a menu as shown below will be displayed.

Select the Filter Selection option.• 
A dialog box will be displayed as shown below.• 
Select what level of selection you want e.g. atom or residue.• 
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4.6.9�Workspace Selections

In the default GUI layout the workspace panel is located to the left of
the 3D graphics display. It is a great tool for keeping track of all
your sequences, pdb structures, objects, tables and alignments. As you
will see in this section it also provides a way of making selections.
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4.6.10�Workspace Navigation

Once you have mastered how to navigate the ICM workspace making a
selection will become easier. Each object is divided into 3 levels:

Object Level - Shown in red if it is the current object. Holds
details about the structure - name, X-ray, NMR, resolution etc.
Importantly it will state whether the structure is an ICM object
or a structure straight from the PDB. To learn how to convert a
PDB into an ICM object go to the section on converting a PDB.

1. 

Molecular Level - Shows the individual subunits, ligands and
hetatoms of a molecule.

2. 

Residue Level - Shows the sequence.3. 

NOTE: You can expand each level of the ICM workspace by clicking the
"+" button as shown above.

4.6.11�How to Select an Object

To select the whole object:

Double click on the object level.• 

Use the CTRL button to select multiple non-contiguous objects or if they
are continuous you can use double click and hold the tab button.

4.6.12�How to select a Molecule

To select a molecule(s):
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Double click on the molecule in the ICM workspace.• 

Use the CTRL button to select multiple non-contiguous molecules or if
they are continuous you can use double click and hold the tab button.

4.6.13�How to select Residues

There are different options to select residues:

OPTION 1:

Click and drag over the residues you wish to select in the ICM
workspace. Selected residues will be highlighted in dark blue in
the workspace and with green crosses in the graphical display.

• 
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OPTION 2:

Click on the rectangular selection icon or lasso selection icon on
the toolbar.

• 

Click and drag around the residues you wish to select. Selected
residues will be displayed by green crosses on the graphical
display and blue in the ICM workspace.

• 

Use the propagate selection to residue level button.• 

OPTION 3:

Right click on the a residue in the graphical display and a menu
as shown here will be displayed.

• 

Click on Select and a further menu will be displayed.• 
Click on Residue, Molecule or Object.• 

64 4.6.13�How to select Residues



OPTION 4:

Use the select residue button.

4.6.14�Select All

Ctrl + A will select everything in the ICM workspace, and Ctrl + Shift +
A will unselect your objects.

NOTE: The selection you have made is always recorded at the top of
the ICM workplace. If you are familiar with using the ICM terminal
(See language manual) the atoms, residues, molecules or objects
selected interactively in the graphics window are automatically s

4.6.15�Selecting Neighbors

In some instances you may only want to display or select only a subset
of a structure. For example you may only wish to display the residues
surrounding a ligand (as shown below (ligand red; graphical selection
green crosses). The "Selecting Neighbors" option selects the residues
within a shpere of a defined radius.

There are two ways of selecting neighbours to a particular atom or
residue in ICM. Either by right clicking on the atom or residue in the
graphical display or by right clicking in the ICM workspace.
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4.6.16�Selecting Neighbors: Graphical

To select neighboring atoms or residues around a sphere of a certain
radius:

First select the residue(s) or atom(s) around which you wish to
select neighbors. (See the Selection Toolbar Section)

• 

Right click on the selection and a menu as shown below will be
displayed or choose Tools/Geometry/Neighbors.

• 

Select the Neigbors option and a data entry box as shown below
will be displayed.

• 

This option will allow you to make a spherical selection.

The window will open as displayed as below:

Select the molecule you wish to select neighbors around. For
example you can select a ligand in the ICM Workspace and then
choose the Graphical Selection option in the "Select Neighbors
For" dialog entry box. Or alternatively you can select the object
by clicking on the drop down button next to the "Select Neighbors
For" dialog entry box.

• 

Enter the radius in Angstroms for the neighbor selection. e.g. 5.• 
Type - this option is important. This option relates to what is
going to be selected. For example if you leave this option as
visible and you only have ribbon representation displayed for your

• 
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receptor (e.g. when selecting neighbors for a ligand) then only
backbone atoms will be selected.

Selection Type option includes:

visible - will select all atoms displayed within the radius
selected.

• 

visible sidechains will select all visible side-chains - not
backbone atoms.

• 

same_object_other_chains will select all atoms in other chains in
the same object as the original selection.

• 

other objects will select atoms in objects other than the original
selection.

• 

same object will select atoms in the same object as the original
selection.

• 

all_objects will select atoms in all objects• 
choose_from_list will allow you to select the object you wish to
include in the neighbors selection.

• 

exclude source if checked will not include your original selection
in the spherical selection.

• 

unselect water if checked will not select water molecules• 
Undisplay Beyond Selection will only display the atoms selected.• 

NOTE: The selection you have made is always recorded at the top of the
ICM workplace. If you are familiar with using the ICM terminal (See
language manual) the atoms, residues, molecules or objects selected
interactively in the graphics window are automatically saved in the
variable as_graph. Graphical selections are shown in green (crosses) or
highlighted in blue in the ICM Workspace.

4.6.17�Selecting Neighbors: Workspace

To select neighboring atoms or residues around a sphere of a certain
radius from a residue in the ICM workspace:

First select the residue in the ICM workspace around which you
wish to select neighbors. (See the Residue Selection)

• 

Right click on the selection and a menu as shown below will be
displayed.

• 
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Select the Neigbors option and a data entry box as shown below
will be displayed.

• 

Follow the instructions in the previous section.• 

NOTE: The selection you have made is always recorded at the top of
the ICM workplace. If you are familiar with using the ICM terminal
(See language manual) the atoms, residues, molecules or objects
selected interactively in the graphics window are automatically s

4.6.18�Select by Residue Number

To select by residue number:

Right click on the molecule you wish to make the selection in and
choose Select/Res Number...

• 

Enter the residue numbers e.g. 3,7:12,30 Colon indicates range.• 

4.6.19�Alignment and Table Selections

Descriptions on how to make selections in Alignments and Tables are in
the sections entitled Making Selections in Alignments and Making Table
Selections.

4.6.20�Making Links

It is sometimes necesary to make links between sequences objects and
alignments. A link enables you to make selections in one environment
such as an alignment and then these selections are transfered to the
object such as the PDB structure displayed.

If a link is made then a symbol will be displayed next to the object in
the ICM workspace. In the example shown below subunit_a of the X-ray
structure 1ql6 is linked to the sequence 1ql6_a and the alignment called
’alig’.

If an object is linked to an alignment a symbol as shown below will be
displayed.

To link a sequence from an object - extract the sequence from the
object.

Right click on the object in the ICM workspace.• 
Select extract sequence.• 
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To link a sequence and object to an alignment.

Use the extracted sequence as described above to build your alignment.

In addition a link can be made between a structure and alignment by:

Bioinfo/Link to Structure.• 
Enter alignment name.• 
OK• 

4.6.21�Tags

It is sometimes convenient to tag selections so you can come back and
use them at a later date. To do this:

Step 1. Select the region you wish to tag.
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Step 2. Right click on the selection and choose Annotation/Add a Tag.

Step 3. Give the tag a name and choose the selection level (atom,
residue, molecule, or object).

70 4.6.21�Tags



Step 4. You will see the tag in the ICM Workspace. You can toggle the
display on or off or select the tag by double clicking on it in the ICM
Workspace.

4.7�Preferences

Your ICM preferences can be changed by:

Select File/Preferences.• 

NOTE: There is a "Reset to Default" button in case you make any
changes you are not happy with and also a search option.

4.7�Preferences 71



4.7.1�Bonds Preferences

To change Bond Preferences:

Select File/Preferences.• 
Choose the Bonds tab.• 

GRAPHICS.ballStickRatio - A default ratio of ball and stick radii. This
ratio is applied when the styles are switched from the GUI xstick
toolbar. Default (1.4)

GRAPHICS.hbond Ball Period - Default (3)

GRAPHICS.hbondMinStrength - parameter determines the hbond strength
threshold for hbond display. The strength value is between 0. and 2. By
changing 1. to 0.2 you will see more weak hydrogen bonds. Default: (1).

GRAPHICS.hbondStyle - determines the style in which hydrogen bonds are
displayed. Here hbond-Donor, Hydrogen, and hbond-Acceptor atoms will be
referred to as D, H and A, respectively,

GRAPHICS.hetatmZoom - The default ball and stick radii of a ligand can
be different by the GRAPHICS.hetatmZoom factor. This makes a better
ligand view since the ligand stands out from the surrounding protein
atoms.

GRAPHICS.stickRadius - radius (in Angstroms) of a cylinder displayed as
a part of stick or xstick graphical representation of a molecule.
Individual (residue-wide) control of stick radii.

GRAPHICS.xstick Backbone Ratio - Default (1.2)

GRAPHICS.xstick Style - xstick style
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wireBondSeparation the distance between two parallel lines representing
a chemical double bond if wireStyle = "chemistry". Default (0.2
Angstroms).

GRAPHICS.distance Label Drag - enable distance label dragging

GRAPHICS.hbondAngleSharpness determines how the strength depends on the
D-H...A(lone pair) angle. The preference can be found the general
Preferences menu Default (1.7)

GRAPHICS.hbond Ball Style even, by atom size, by energy or telescopic

GRAPHICS.hbond Rebuild

GRAPHICS.hbondWidth relative width of a displayed hbond .

GRAPHICS.hydrogenDisplay determines the default hydrogen display mode
for the display command.

 GRAPHICS.hydrogenDisplay = "polar" 
        1 = "all"   # all hydrogens are shown 
        2 = "polar" <-- current choice  # polar displayed, the non-polar hidden 
        3 = "none"  # no hydrogens are displayed 

GRAPHICS.wire Width - relative width of wire Default (1)

GRAPHICS.xstick Hydrogen Ratio - Default (0.5)

GRAPHICS.xstick Vw Ratio - Default (0.6)

Wire Style - change the default wire style

 GRAPHICS.hbondStyle = "dash" 
        1 = "wire"      # Just a line 
        2 = "chemistry"    # shows different types of chemical bonds.
        3 = "tree"  # shows a directed graph of the ICM-molecular tree
        4 = "aromatic"  # 

4.7.2�Directories Preferences

DIRECTORIES TAB:

To change Directory Preferences:

Select File/Preferences.• 
Choose the Directories tab.• 

Within this tab you can select the default directories for:

FILTER.gz, FILTER.uue, FILTER.Z, Filter.zip allows you to read
compressed files .gz, .uue, .Z, and, .zip files automatically leaving
the compressed file intact.

PDB Directory Style - The style of your Protein Data Bank
directory/directories. ICM will understand all of the listed styles,
including distributions with compressed *.gz , *.bz2 and *.Z fil es

BlastDB Directory - return directory with Blast-formatted sequence files
for ICM sequence searches.You can download Blast formatted databases
from here ftp://ftp.ncbi.nih.gov/blast/db/

Dock Directory - Default directory for storing docking files.

CCP4 Directory

Editor - Select a default text editor
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Inx Directory - location of stored index (*.inx) files.

Log Directory - when you quit an icm-session, a _seslog.icm file is
automatically stored. If the s_logDir variable is empty, it is stored to
the s_userDir + "/log/" directory. However one can redirect it to the
current working directory ( "." ) or any other directory.

Output Directory -

PDB Directory - directory containing the PDB database of 3D structures.
These files can also be easily downloaded directly from the PDB site if
the variables are set as in the example below. PDB distributions can
exist in several styles (all files in the same directory, or divided
etc.).

PDB Directory FTP

PDB Directory Web

Projects Directory - Select the default location for storing ICM
projects. Save your data in an ICM project. It is a convenient way of
keeping all your structures, alignments, tables, docking results etc...
in one place. A description on how to save an ICM project is described
in the GUI Basics section of this manual.

Prosite Dat - location of the prosite.dat file a dictionary of protein
sites and patterns, (Copyright by Amos Bairoch, Medical Biochemistry
Department, University of Geneva, Switzerland).

Ps Viewer - Select a postscript viewer

Swissprot Dat - location of swissprot.dat file

Temp Directory - scratch directory for temporary files ( some montecarlo
files will be saved there ).

Uniprot Dat - location of uniprot.dat file

XPDB Directory - Path to the ICM XPDB database of compact binary ICM
objects which are annotated with the site information. The advantage of
the XPDB database is the speed of reading and smaller size than PDB.
XPDB entries are read about 80 times faster!

TOOLS.default ChemDB

TOOLS.eds Directory

TOOLS.pdb Read Nmr Models

   1. = "first" : reads only one model from a multi-model (e.g. NMR) pdb file
   2. = "all" : reads all models from a multi-model (e.g. NMR) pdb file and creates a separate object for each of them
   3. = "all stack" : creates one object and loads all other models as a stored cartesian stack 

4.7.3�Graphics Preferences

To change Graphics Preferences:

Select File/Preferences.• 
Choose the Graphics tab.• 

Atom Single Style - display style of isolated atoms in the wire mode.

   1. "tetrahedron"
   2. "cross"
   3. "dot" 

GRAPHICS.clash Style - choose clash length, strain or length.
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GRAPHICS.clip Grobs - enable grob clipping.

GRAPHICS.clip Static -

GRAPHICS.grobLineWidth - relative width of displayed lines of 3D meshes
( grobs ). Also affects the interatomic distance display.

GRAPHICS.lightPosition - X ,Y and Z posiion of the light source in the
graphics window. The X and Y coordinates are usually slightly@@ beyond
the [-1. 1] range where [-1.,1.] is the size of the window, and the Z
position is perpendicular to the screen and is set to 2. (do not make it
negative).

GRAPHICS.occupancyDisplay preference controlling if and how the
partical or zero atom occupancies are displayed. The abnormal
occupanices are shown as circles around atoms. These following values
are allowed.

   1. = "none" # nothing is displayed
   2. = "circle" # a circle is displayed
   3. = "label" # a circle and a lable with the value (zero values are not shown) 

GRAPHICS.quality - integer parameter controlling quality (density of
graphical elements) of such representations as cpk, ball, stick, ribbon
. Do not make it larger than about 20 or smaller than 1.

GRAPHICS.ruler Style - change ruler from center to side

GRAPHICS.stereoMode - 1. "up-and-down", 2. "line interleaved" 3.
"in-a-window"

a simple hardware stereo mode for workstations with a horizontal
frame splitter.

• 

In the "up-and-down" mode a longer frame with two stereo images on
top of each other is generated and the two halves are then
superimposed with the splitter. This mode does not require
anything from a graphics card, but does require a frame splitter.
A frame splitter box was connected between a monitor and a
graphics card output. This mode has an unpleasant side effect, the
rest of the screen (beyond the OpenGl window) becomes stretched
and the lower part of the screen is superimposed on the top half.

• 

The "line interleaved" mode can be used with a new type of frame
splitter at the line level. In this case the odd lines from one
stereo-image are interleaved with the even lines of another. The
side-effect of this mode is that the intensity is reduced in half
since at each moment one sees only one half of the lines. The
splitter device for this mode can be purchased from Virex
(www.virex.com). This mode produces a dark stereo image but is
easily available (requires stereo goggles, e.g. from Virex).

• 

The "in-a-window" mode is used in SGI workstations and in a Linux
workstation with an advanced graphics card supporting a quad
graphics buffer. In this mode the hardware stereo regime applies
only to an OpenGl window. This is the best mode but it requires an
expensive graphics card (plus the stereo goggles).

• 

GRAPHICS.surfaceDotDensity - Determines the number of dots per square
Angstrom on the graphical solvent accessible surface.

GRAPHICS.surfaceProbeRadius - An increment to the van der Waals radii
of atoms at thich the dotted atomic surface is calculated. It is used by
the display surface command to display dotted van der Waals surface. If
the GRAPHICS.surfaceProbeRadius is set to 1.4 the surface becames
equivalent to the solvent accessible surface with a probe of 1.4A

GROB.arrowRadius - a real arrow radius in Angstoms used by the Grob(
"ARROW", R_ ) function. Default: 0.5.
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GROB.contourSigmaIncrement - a real increment in the sigma level used
to re-contour an electron density map using the make grob m_eds add
r_increment command. This parameter is used in the GUI when plus and
minus are pressed.

GROB.relArrow Size - a real ratio of the arrow head radius to the arrow
radius. This parameter is used by the Grob( "ARROW", R_ ) function.
Default: 3.0.

shineStyle - defines how solid surfaces of cpk , skin and grobs reflect
light. Possibilities:

   1. "white" <- default
   2. "color" 

The first option gives a more shiny and greasy look.

GRAPHICS.center Follows Clipping - determine the function of center
button.

GRAPHICS.clashWidth - relative width of a displayed clash .

GRAPHICS.clip Skin - enable skin clipping.

GRAPHICS.displayMapBox - controls if the bounding box of a map is
displayed

GRAPHICS.light - a rarray of 13 elements between 0. and 1. which
controls the main properties of lighting model in GL.

GRAPHICS.mapLineWidth - relative width of lines and dots of a displayed
map.

GRAPHICS.occupancy Radius Ratio - preference controlling the radius of
the partical or zero atom occupancies

GRAPHICS.resize Keep Scale

GRAPHICS.selectionStyle - preference for the style in which the
graphical selection is shown. The preference may have the following
values.

GRAPHIC.store Display - maintains representation and coloring for an
object.

GRAPHICS.surfaceDotSize - Determines the size of the dot on the solvent
accessible graphical surface.

GRAPHICS.transparency - Two parameters regulating the transparency of
grobs.

GROB.atomSphereRadius - default radius (in Angstroms) which is used to
select a patch on the surface of a grob.

GROB.relArrowHead - a real ratio of the arrow head radius to the arrow
radius.

lineWidth - the real width of lines used to display the wire
representation of chemical bonds.

4.7.4�GUI Preferences

GUI TAB:

The options contained within the Preferences/Gui tab are described
below.
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GRAPHICS.alignment Rainbow - This option controls how alignments are
colored by default.

GRAPHICS.NtoC Rainbow - Controls the coloring of structural
representation from the N-terminal to the C-terminal

GRAPHICS.rocking - Controls default rocking motion.

GRAPHICS.rocking Speed - Controls rocking or rotation speed.

GUI.auto Save Interval - Controls auto save period (minutes)

GUI.table Row Mark Colors - Controls colors used for marking tables.

GUI.workspaceTabStyle - Controls the style of ICM-object tabs created
in the workspace panel of ICM GUI.

Movie.fade Nof Frames - Controls number of frames for the fade out
option in screenshot movie making.

Movie.quality - Controls the resoltuion of the movie

SEQUENCE.site Colors - Controls coloring of squence sites.

SLIDE.ignore Fog - Fog representations can be ignored in slide
preparation if desired.

GRAPHICS.discrete Rainbow -

GRAPHICS.rainbow Bar Style - determines if and where the color bar will
appear after a molecule is colored by an array.

GRAPHICS.rocking Range - real value of rocking range.

GUI.auto Save - auto save on or off

GUI.max Sequence Length - maximum sequence length displayed in ICM

GUI.workspace Folder Style - Workspace folder style.

MOVIE.frame Grab Mode - with screenshot movie making you can choose
either fixed frame time or real time.

Movie.quality Auto - with screenshot movie making you can allow ICM to
control the movie resolution.

SLIDE.ignore Background Color - Ignore background color when you are
making a slide.

4.7.5�GUI Preferences

To change GUI Preferences:

Select File/Preferences.• 
Choose the GUI tab.• 

Quality - controls the quality (density of graphical elements) of such
representations as cpk, ball, stick, ribbon . Do not make it larger than
about 20 or smaller than 1. We recommend to make this parameter at least
15 if you want to make a high quality image. You can also increase the
number of image resolution by making the image window 2,3,4 times larger
(in the example below it is 2 times larger) than the displayed window.

Wire Style - Four different wire styles are available.
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Hydrogen Display - Select whether you always want all hydorgens
displayed or just-polar hydrogens or no hydrogens at all.

Rainbow Scale - determines if and where the color bar will appear after
a molecule is colored by an array. Coloring by an array is one of the
options of the display and color commands.

   1. = "left" <- default choice
   2. = "right"
   3. = "no text"
   4. = "no bar" 

Ball Ratio - The ratio of ball and stick radii. This ratio is applied
when the styles are switched to xstick from the GUI xstick toolbar.

Selection Style - Change the graphical display of your selections.
Default is a green cross.

Clash Threshold - a clash is defined as an interatomic distance less
than a sum of van der Waals radii of two atoms of interest multiplied by
the clashThreshold parameter. For hydrogen bonded atoms, the distance
threshold is additionally reduced by 20% . Default = 0.82

DotSurfaceRadiusIncrement - adius of a probe sphere used to display a
dotted surface of a molecule. All van der Waals radii are expanded by
this value. vwExpand=0 corresponds to the CPK surface, vwExpand=1.4
corresponds to the water-accessible surface. Be aware of the difference
between the waterRadius and vwExpand parameters: waterRadius is used in

show energy "sf"• 
show [area|volume] skin• 
display skin while vwExpand is used in• 
show [area|volume] surface• 
display surface• 

Default (1.4).

H Bond Style - How do you wish your H-Bonds to be displayed by default?
Dashes, Bond Length, Bond Lenght and Angle.

grobLineWidth - relative width of displayed lines of 3D meshes ( grobs
). Also affects the interatomic distance display.

general line with - the real width of lines used to display the wire
representation of chemical bonds. See also IMAGE.lineWidth parameter
which controls line thickness in molecular images generated by the write
postscript command, and the PLOT.lineWidth which controls the width for
the plot command. Default (1.0)

single atom as - display style of isolated atoms in the wire mode.

1. "tetrahedron"
2. "cross"
3. "dot" 
The size of the first two representation is controlled by the GRAPHICS.ballRadius parameter and the line width (especially important for the "dot" style) is controlled by the lineWidth parameter.

xstickhetatomzZoom - The default ball and stick radii of a ligand can be
different. This makes a better ligand view since the ligand stands out
from the surrounding protein atoms.

solid shine style - choose either white or color

Stick Radius - radius (in Angstroms) of a cylinder displayed as a part
of stick or xstick graphical representation of a molecule. Individual
(residue-wide) control of stick radii.

Stereo Mode - Select a default stereo mode
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Display Style - A default display style can be chosen using a
combination of styles.

Water Radius - radius of water sphere which is used to calculate an
analytical molecular surface (referred to as skin) as well as the
solvent-accessible surface (centers of water spheres).

clashWidth - relative width of a displayed clash.

hbondWidth - relative width of hydrogen bond display

mapLineWidth - relative width of lines and dots of a displayed map.

4.7.6�Image Preferences

To change Image Preferences:

Select File/Preferences.• 
Choose the Image tab.• 

IMAGE.color - logical to save color or black_and_white (’bw’) images.

IMAGE.gammaCorrection - real variable to to lighten or darken the image
by changing the gamma parameter. A gamma value that is greater than 1.0
will lighten the printed picture, while a gamma value that is less that
1.0 will darken it.

IMAGE.lineWidth - this real parameter specifies the default line width
for the postscript lines.

IMAGE.orientation - image orientation.

IMAGE.previewer - a string parameter to specify the external filter
which creates a rough binary (pixmap) postscript preview and adds it to
the header of the ICM-generated high resolution bitmap or vectorized
postscript files saved by the write image postscript, and write
postscript , respectively .

IMAGE.print - unix command for printer.

IMAGE.scale - real variable. If non zero, controls the image scale with
respect to the screen image size.

IMAGE.stereoBase - real variable to define the stereo base (separation
between two stereo panels) in the write image postscript and write
postscript command.

IMAGE.writeScale - an integer parameter used to increase the image
resolution in the Quick Image Write tool.

IMAGE.bondLength2D - real length of a chemical bond (in inches) in
chemical 2D drawings upon the Copy Image command.

IMAGE.compress - logical to toggle simple lossless compression, standard
for .tif files. This compression is required to be implemented in all
TIFF-reading programs.

IMAGE.generateAlpha - logical to toggle generation of the alpha
(opacity) channel for the SGI rgb, tif and png image files to make the
pixels of the background color transparent.

IMAGE.lineWidth2D - integer thickness of bonds in chemical 2D drawing
upon the Copy Image command. This is useful for cutting and pasting from
ICM to external documnents.

IMAGE.paper Size - specify paper size.
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IMAGE.previewResolution - integer resolution of the rough bitmap
preview added to the vectorized postscript file in lines per inch.

IMAGE.printerDPI - this integer parameter the printer resolution in Dot
Per Inch (DPI). Important for the write image postscript command.

IMAGE.stereoAngle - real variable to define stereo angle (relative
rotation of two stereo images) in the write image postscript and write
postscript command.

IMAGE.stereoText - logical to make text labels for only one panel or
both panels of the stereo diagram.

4.7.7�Label Preferences

To change Label Preferences:

Select File/Preferences.• 
Choose the Labels tab.• 

atomLabelStyle style of atom labels invoked by clicking on an the atom
label button.

GRAPHICS.displayLineLabels - enables/disables the display of edge
lengths (inter-point distances) of a grob generated with the Grob(
"distance" .. ) function.

GRAPHICS.font Line Spacing - Change the spacing between lines in labels.

GRAPHICS.resLabelDrag - if yes, enables dragging of the displayed
residue labels with the middle mouse button.

GRAPHICS. site Arrow - Highlight sites with an arrow yes or no.

Show Res Code In Selection - When you make a selection the icm selection
language will be displayed when you right click on the selection.

Res Label Style - Default residue label style.

SITE.label Style - Default label sites style.

Var Label Style - Default label variable style.

GRAPHICS.atomLabelShift - a non-negative integer number of spaces
preceding an atom label. This parameter is useful for displaying labels
next to a solid representation,

GRAPHICS.fontColor - set font color

GRAPHICS.font Scale - set font size

GRAPHICS.site Label Shift - GRAPHICS.resLabelShift a non-negative
integer number of spaces preceding a site label.

GRAPHICS. site Label Drag - if yes, enables dragging of the displayed
site labels with the middle mouse button.

Res Label Shift - a non-negative integer number of spaces preceding a
residue label. This parameter is useful for displaying residue labels
next to a solid

SITE.labelOffset - (default 5. A) the real offset of the site label with
respect to the residue label atom.

SITE.wrap Comment - Number of characters per comment line.
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4.7.8�Plot Preferences

To change Plot Preferences:

Select File/Preferences.• 
Choose the Plot tab.• 

PLOT.color - logical to generate a color plot. Usually it does not make
sense to switch it off because your b/w printer will interpret the color
postscript just fine anyway.

PLOT.draw Tics logical yes or no

PLOT.fontSize real font size. Any reasonable number from 3. (1 mm, use a
magnifying glass then) to 96.

PLOT.lineWidth - real line width for graphs (not the frame and tics)

PLOT.markSize - real mark size in points. Allowed mark types: line,
cross, square, triangle, diamond, circle, star, dstar, bar, dot, SQUARE,
TRIANGLE, DIAMOND, CIRCLE, STAR, DSTAR, BAR. Uppercase words indicate
filled marks.

PLOT.paper Size - preference to specify plor paper size

PLOT.rainbowStyle - preference defining the color spectrum used by the
plot area command.

PLOT.Yratio - real aspect ratio of the ICM plot frame. Using link option
of the plot command is equivalent to setting this variable to 1.0. If
PLOT.Yratio is set to 0. , the ratio will be set automatically to fill
out the available box optimally.

[PLOT.date} - display date on plot

PLOT.font - preference for the title/legend font.

PLOT.labelFont - preference for the data point label font.

PLOT.logo - logical switch for the ICM-logo on the plot.

PLOT.orientation - preference for the plot orientation.

PLOT.previewer - command to local ps viewer

PLOT.seriesLabels - preference to indicate position of a series/color
legend inside the plot frame.

4.7.9�Ribbon Preferences

To change Ribbon Preferences:

Select File/Preferences.• 
Choose the Ribbon tab.• 

Combo Display Style - select ribbon-cpk, atoms, ribbon-ligand, chemical

GRAPHICS.dnaRibbonRatio - real ratio of depth to width for the DNA
ribbon .

GRAPHICS.dnaRibbonWorm - logical which, if yes, makes the DNA backbone
ribbon round, rather than rectangular. Default: no

GRAPHICS.dnaWormRadius - real radius of the worm representing bases in
DNA ribbon .
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GRAPHICS.ribbonWidth - real width of the protein ribbon .

GRAPHICS.wormRadius - radius of coiled segments (i.e. those where the
secondary structure is marked as "_") of a polypeptide chain in ribbon
representation. Default (0.3).

Ribbon Style - specifies default style when ribbon is displayed.

GRAPHICS.dnaBallRadius - DNA bases in ribbon representation are shown
as balls controlled by this real parameter.

GRAPHICS.dnaRibbonWidth - real width (in Angstroms) of the DNA ribbon .

GRAPHICS.dnaStickRadius - real radius of the sticks representing bases
in DNA ribbon .

GRAPHICS.ribbonRatio - real ratio of depth to width for the protein
ribbon .

GRAPHICS.ribbonWorm - logical parameter, if yes, makes the ribbon round,
rather than rectangular.

ribbonColorStyle -

- sets the ribbon coloring scheme.
1 = "type"      default. colors by secondary structure type or explicit color
2 = "NtoC"      colors each chain gradually blue-to-red from N- to C- (or from 5’ to 3’ for DNA)
3 = "alignment" if there is an alignment linked to a protein, color gapped backbone regions gray
4 = "reliability"       3D gaussian averaging with selectSphereRadius of alignment strength in space
If ribbonColorStyle equals to 4, the conserved areas will be colored blue, while the most divergent will be red, and the intermediate conservation areas will be colored white. Example:

4.7.10�Shell Preferences

To change Shell Preferences:

Select File/Preferences.• 
Choose the Shell tab.• 

Clash Threshold - a clash is defined as an interatomic distance less
than a sum of van der Waals radii of two atoms of interest multiplied by
the clashThreshold parameter.

Map Sigma Level - (in Rmsd values over the mean value). Margin value
used for making graphical objects contouring the 3D density map .

Mnconf - maximal number of conformations in the conformational stack .
The stack stops growing after this number is achieved and starts
replacing representative conformations with higher energy values by new
conformations with superior energies, if the latter are found.

Icm Prompt - defines the ICM-prompt string.

Select Min Grad - default minimal gradient vector length for gradient
atom selection ( a_//G). This parameter is also used by the montecarlo
fast command, which requires a value of 2. to 10. for optimal
performance.

Map Atom Margin - Margin in Angstoms around selected atoms. The margin
is added to the positional boundaries to define a submap index box in
the Map ( map_source , as_ ) function.

maxColorPotential - local electrostatic potential in kcal/e.u.charge
units at which the surface element is colored by extreme red or extreme
blue. All higher values will have the same color. This absolute scaling
is convenient to develop a feeling of electrostatic properties of
molecular surfaces.
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mnSolutions - this parameter limits the number of hits retained by the
program after a search.

Real Format - format of real numbers

Water Radius - radius of water sphere which is used to calculate an
analytical molecular surface

4.7.11�System Preferences

To change System Preferences:

Select File/Preferences.• 
Choose the System tab.• 

FTP.createFile -

FTP.proxy - string path to the proxy server for connections through
firewall. Default: "" (empty string).

GUI.max Nof Recent Files - maximum number of recent files stored.

GUI.splash Screen Image - path to splash image displayed on startup

HTTP. support Cookies - http support cookies yes or no

HTTP.user Agent - client application used within a particular network
protocol for www

Beep - warning beep yes or no

Max File Size Mb - Maximu file size in MegaBytes that can be loaded into
ICM.

USER.friends

USER.organization

FTP.keep File - (default no ). If yes, the temporary file is kept in the
s_tempDir directory. Otherwise the file is deleted.

GUI.enumberation Memory Limit - memory limit for enumeration operations.

GUI.splash Screen Delay

HTTP.proxy - string for HTTP server for connection through firewall

HTTP.timeout - timeout in seconds

Http Read Style icm or lynx

Force Auto Bond Typing - yes/no

USER.email, USER.full Name, USER.phone
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5�Protein Structure

Chapter Contents:

How to Convert Proteins and Chemicals to ICM Objects.• 
Binding Site Display Tools.• 
Crystallographic Analysis Tools.• 
Protein Superposition.• 
Protein Structure Analysis.• 
Protein Structure Prediction Tools e.g. ICM Pocket Finder.• 

5.1�Convert to ICM Object

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro | ICM-Chemist

5.1.1�Load a Protein Structure

There are a couple of ways to read into ICM a protein structure.

Search the PDB using the Search Tab.1. 
Load in a PDB file that you have saved on your computer using
File/Open.

2. 

5.1.2�Converting PDB Files Into ICM Objects

If you are going to make any type of energy calculation in ICM (eg
docking, display H-bonds, display electrostatic and binding property
surfaces etc..) it is necesary to convert a protein or chemical into an
ICM object. Be aware that upon conversion ICM adds missing side-chain
atoms (but wont try to build missing loops) due to the nature of the
internal-coordinate system. The list of residues/ atoms added is
presented in the command line shell and can be reviewed. For reference,
the original PDB entry is kept in the system. See the command line
manual for a more complete description of what the conversion process
does.

NOTE: Before converting a protein structure to an ICM object make
sure that the chemicals contained within the structure (e.g. ligands)
are correct. If an error is found you can edit the ligand as
described here.

To convert a PDB structure into an ICM object follow the steps shown
below:
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Right click on the name of the protein you wish to convert in the
ICM Workspace.

• 

A dialog box will be displayed as shown below.• 
If you want to delete the water molecules select Delete Waters• 
If you want to optimize hydrogen atoms (recommended for important
work) select Optimize Hydrogens. This option performs global
optimization of hydrogens to find the best hydrogen bonding
network.

• 

If you want to optimize the orientation of His, Pro, Asn, Gln, Cys
residues then choose optimizeHisProAsnGlnCys. The following
residues will be further optimized: His - three protonation states
and two rotations will be tried and the residue will be renamed
according to its subtype: hie (epsilon tautomer) or hip (+). Asn
and Gln - (a 180 deg. flip will be tried). Cys - in the vicinity
of Zn, Cu, Fe and Co to cym.

• 

If you want to keep a copy of your PDB file uncheck the option
replace original.

• 

The converted structure can be displayed immediately by checking
display the result

• 

Uncheck the box hide missing side chains if you want ICM to build
missing heavy atoms that are not reported in the PDB (due to the
lack of density), they will be added according to the residue name
and assigned zero occupancies. Check this box if you want residues
missing heavy atoms to be hidden.

• 

If your object is an ICM object it will display ICM next to the molecule
in the ICM Workspace.
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5.2�Pocket Display

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

5.2.1�Receptor Pocket Surface.

To display the Receptor Pocket Surface:

As an example we will use the PDB structure 1STP. Type 1STP in the
pdb search tab and press return.

• 

Convert the protein to an ICM object. If you do not convert a
generic surface will be displayed that is not colored by binding
property.

• 

Right click on the ligand "abtn" and select Pocket/Receptor
Pocket.

• 

Select whether you would like to display side-chain hydrogen bonds
and label.

• 

The receptor pocket will be displayed colored by binding property
- White=aromatic lipophilic, Green=non-aromatic other (mostly
aliphatic) lipophilic surface, Red=hydrogen bonding acceptor
potential, Blue=hydrogen bond donor potential.

• 

The surface can be toggled on and off by selecting in the ICM
Workspace in the meshes section.

• 
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5.2.2�Ligand Surface.

The Ligand Surface option allows you to visualize cavities that are open
for ligand modifications. To display the Ligand Surface:

As an example we will use the PDB structure 1STP. Type 1STP in the
pdb search tab and press return.

• 

Convert the protein to an ICM object. If you do not convert a
generic surface will be displayed that is not colored by binding
property.

• 

Right click on the ligand "abtn" and select Pocket/Ligand Surface.• 
The Ligand Surface will be displayed colored by binding property -
White=aromatic lipophilic, Green=non-aromatic other (mostly
aliphatic) lipophilic surface, Red=hydrogen bonding acceptor
potential, Blue=hydrogen bond donor potential.

• 
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5.2.3�How to Display Hydrogen Bonds

NOTE: The method by which hydrogen bonds are calculated is described
here in the command line manual. The GRAPHICS.hbondMinStrength
parameter determines the hbond strength threshold for hbond display.
The strength value is between 0. and 2. By changing 1. to 0.2 you
will see more weak hydrogen bonds.

In order to display energy related properties we need to convert
the PDB file into an ICM object. Convert 1STP into an ICM object.
In this example, the option "Replace the Original" was selected.

• 

Display the receptor in wire format and the ligand in xstick.• 
Right click on the ligand and select "Neighbors" - Enter 3
Angstroms and Type = Visible. Do not exclude source (the ligand)
therefore remove tick from box entitled "exclude source".

• 

Select the display tab and then select the Display H-Bond button.• 
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NOTE: Different options for displaying the H-bond can be accessed by
clicking and holding on the H-bond button in the "Display" tab. The
coloring of the H-bonds are red (strong - thick spheres) to blue
(weak - thin spheres). Once the hydrogen bonds have been displayed
they can be displayed and undisplayed in the 3D labels section of the
ICM Workspace (left hand side of graphical window).

5.2.3.1�Edit Hydrogen Bond Label

To edit a hydrogen bond label

Right click on the label.• 
Choose Edit Label.• 
Make changes in the dialog box and press OK.• 
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5.2.3.2�Move Hydrogen Bond Label

To move a hydrogen bond label

Right click on the label.• 
Click on the label using the middle mouse button.• 
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Hold the middle mouse button down and drag.• 

5.2.4�Ligand Pocket Interactions

To view the ligand pocket interactions.

Right click on the ligand and choose Pocket.• 
Choose Ligand Pocket Interactions. Hydrogen bonds, key waters and
neighboring residues will be displayed.

• 
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5.3�Protein Superposition

Available in the following product(s): ICM-Browser-Pro | ICM-Pro

 One or more proteins can be superimposed. Simply select
the molecules or parts of the molecules you wish to superimpose and then
use the selection of protein superimpose tools described in this
section. A convenient superimpose button can be found in the Display tab
(see image of button (left).

Chapter Contents:

Select Proteins for Superposition• 
Superimpose Button• 
Superimpose by 3D• 
Superimpose Multiple Proteins• 
Arrange as Grid• 
Superimpose Sites by Atomic Property Fields• 
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5.3.1�Select Proteins for Superposition

Before any superposition operation can be undertaken you need to select
the protein structures you wish to superimpose.

One way to do this is by selecting in the ICM workspace. For other
selection tools please see the Making Selections section of the manual.

Select both receptors by double clicking on the name of the
molecule in the ICM Workspace. To select two molecules use the
Ctrl button or use the shift button to select a range of objects
in the ICM Workspace. A receptor which is selected will be
highlighted in blue in the ICM Workspace and with green crosses in
the graphical display.

• 

Once the molecules are selected you can then superimpose them using the
options described in the next section of this manual.

5.3.2�Superimpose Button

A convenient way to superimpose two molecules is by using the
superimpose button in the display tab, ICM will calculate the Ca-atom,
backbone atom and heavy atom differences between the two structures.
More advanced superimpose options can be found in the Tools/Superimpose
menu.

To superimpose:

First load the two structures into ICM.• 
Select which parts or all of the two structure you wish to
superimpose (see the chapter on Selections or the description
protein-superposition-select{here}.).

• 

Select the display tab (previously called Advanced tab) at the top
of the GUI.

• 

Select the superimpose button.• 
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The rmsd will be displayed in the terminal window as shown below:

NOTE: You do not need to select the whole molecule, the superimpose
button will work on small selections e.g the loop regions or domains.
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6�Molecular Graphics
In this chapter we describe how to
make beautiful graphical
representations of molecules and
manipulate them in the 3D graphics
window. This includes how to change
color, light, represenations,
clipping planes, and how to use
built in graphics effects. We also
teach how to label and annotate
molecules displayed in the graphical
user interface.

Chapter Contents:

Molecule Representation• 
Meshes-Surface-Grobs• 
Coloring• 
Lighting• 
Labeling and Annotation• 
Display Distances and Angles• 
Graphics Effects• 
Graphics Shortcuts• 
Molecule Move Buttons• 
Clipping Tools• 
Graphic Layers• 
High Quality Publication Images• 
Movies• 

6.1�Molecule Representation

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

To change the molecule display representation:

Select the atoms, residues, molecules, or objects you wish to
change in the graphical display or in the ICM Workspace.

• 

Then use the molecule representation (e.g. wire, ribbon) options
in the Display Tab.

• 

The display tab contains tools for a variety of functions including -
structural representations, coloring, labeling and superposition.

There are six main types of structural representation in ICM. They are
wire, ball and stick (Xstick), ribbon, skin, CPK and dot envelope
(surface).

To display one of these representations:

Click on the representation button you desire in the display tab.• 
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To remove a displayed representation or to toggle between display and
undisplay:

Click on the corresponding representation button in the display
tab.

• 

Identify which representations are displayed: The button display will
change appearance (shaded blue) when selected. This makes it easier to
identify which representations are currently being displayed.

Change the display and size of the representations Many characteristics
of the graphical representation such as color can be changed by clicking
and holding on the button. The size can be changed by clicking the
plus(+) and minus(-) buttons next to them.

6.1.1�Wire Representation

Click and hold on the wire representation button. A menu will be
displayed as shown below.

98 6.1�Molecule Representation



To change the wire style:

Click and hold on the wire representation button and then click on
wire, chemistry or tree.

• 

To change the size of the wire representation:

Click and hold on the wire representation button and then click on
thin, normal or thick.

• 

NOTE: Clicking on the +/- next to the wire representation button also
changes the thickness of the wire representation.

To undisplay representations other than wire:

Click and hold on the wire representation button and then click on
undisplay other representations.

• 

If you make a mistake or you are not happy with the way your structure
is displayed with the wire representation:

Click and hold on the wire representation button and then click on
reset to default.

• 

6.1.2�Stick and Ball (Xstick) Representation

Click and hold on the stick and ball representation button. A menu will
be displayed as shown below.
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To change the style of the Xstick representation:

Click and hold on the stick and ball representation button and
then click on style and choose either plain, chemistry, Chem Plus,
or Chem Plus Aromatic.

• 

To change the size of the Xstick representation:

Click and hold on the stick and ball representation button and
then click on set thickness , set ball/stick ratio, set hydrogen
ratio, and set backbone ratio.

• 

NOTE: Clicking on the +/- next to the xstick representation button
also changes the thickness of the xstick representation.

In order to make some parts of your picture clearer, the xstick
representation can be set to transparent:

Click and hold on the stick and ball representation button and
then click on transparent.

• 

To undisplay representations other than xstick:

Click and hold on the stick and ball representation button and
then click on undisplay other representations.

• 

If you make a mistake or you are not happy with the way your structure
is displayed with the xstick representation:

Click and hold on the stick and ball representation button and
then click on reset to default.

• 

6.1.3�Ribbon Representation

Click and hold on the ribbon representation button and a menu will be
displayed.

To change the style of the Ribbon representation:

Click and hold on the ribbon representation button and then click
on a style option: smooth, wide, wide smooth, cylinders, protein
worm .

• 
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To assign secondary structure:

To accurately represent the secondary structure of the molecule in
ribbon representation you may wish to assign secondary structure:

Click and hold on the ribbon representation button and then click
on assign sec. structure.

• 

To make some parts of your picture clearer, the ribbon representation
can be set to transparent:

Click and hold on the ribbon representation button and then click
on transparent.

• 

To undisplay representations other than ribbon:

Click and hold on the ribbon representation button and then click
on undisplay other representations.

• 

If you make a mistake or you are not happy with the way your structure
is displayed with the ribbon representation:

Click and hold on the ribbon representation button and then click
on reset to default.

• 

NOTE: Always use the ICM assign sec.** structure tool in the ribbon
right click menu to get accurate secondary structure assignment. This
is particularly important when studying helices which may have
non-cannonical elements within them such as 3/10 or pi. To view
non-cannonical helix segments use the segment option in the ribbon
right click menu.

To change the display of chain breaks (dotted lines):

Click and hold on the ribbon represenation button.• 
Select the options Display Chain Breaks or Display Chain Break
label.

• 

6.1.4�Skin Representation

Click and hold on the skin representation button. A menu will be
displayed as shown below.

To make some parts of your picture clearer, the skin representation can
be set to tight, normal or sparse:

Click and hold on the skin representation button and then click on
either tight, normal or sparse.

• 

To undisplay representations other than skin:
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Click and hold on the skin representation button and then click on
undisplay other representations.

• 

If you make a mistake or you are not happy with the way your structure
is displayed with the skin representation:

Click and hold on the skin representation button and then click on
** reset to default**.

• 

NOTE: Sometimes due to singularity problems holes may appear within
the skin surface. To cure this infliction select atoms nearby and
right click select Advanced->RandomizeAtoms

6.1.5�CPK Representation

Click and hold on the CPK representation button. A menu will be
displayed as shown below.

To undisplay representations other than CPK:

Click and hold on the CPK representation button and then click on
undisplay other representations.

• 

If you make a mistake or you are not happy with the way your structure
is displayed with the cpk representation.

Click and hold on the CPK representation button and then click on
reset to default.

• 

6.1.6�Surface Representation

Click and hold on the surface representation button. A menu will be
displayed as shown below.
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To change the style of the surface representation:

Click and hold on the surface representation button and then click
on tight, normal, or surface.

• 

To undisplay representations other than surface:

Click and hold on the surface representation button and then click
on undisplay other representations.

• 

If you make a mistake or you are not happy with the way your structure
is displayed with the surface representation:

Click and hold on the surface representation button and then click
on reset to default.

• 

6.1.7�Display and Undisplay Hydrogens

To display and undisplay hydrogens. Click and hold on the "Change
Hydrogen Display" button shown below. Multiple single clicks will toggle
through the hyrogen display options.

Display Tab• 
Click and hold on the "Change Hydrogen Display" button shown
below.

• 
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6.1.8�Display Hydrogen Bond

NOTE: The method by which hydrogen bonds are calculated is described
here in the command line manual. The GRAPHICS.hbondMinStrength
parameter determines the hbond strength threshold for hbond display.
The strength value is between 0. and 2. By changing 1. to 0.2 you
will see more weak hydrogen bonds.

In order to display potential hydrogen bonds in your structure:

Convert to an ICM Object• 
Make a selection - if you are trying to display the H-bonds
between a ligand and the receptor make sure the ligand is part of
the selection.

• 

Click the Display Tab.• 
Click on the Toggle H-bonds icon in the display tab.• 
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Click the +/- on the right of the H-Bond button to change
thickness of H-bond representation.

• 

Click and hold the button to change representation or use the
hbondpairs option in the ICM Workspace.

• 

What do the default coloring of the H-bond represent?

Longer and shorter H-X distances in the hydrogen bond are color-coded,
from red to blue, respectively.

NOTE Dynamic hydrogen bonds can be set by clicking and holding on the
H-bond toggle button in the Display tab. Hydrogen bonds will then
respond to any changes made to the ligand.
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6.1.9�Display Formal Charges

You can display formal charges by clicking and holding on the "Change
Hydrogen Display" button in the Display tab.

6.1.10�Ca (carbon alpha) Trace

To generate a carbon alpha (Ca) trace:

Right click on the object in the ICM workspace and select
Tools/Make Ca-Trace object.

• 

The Ca-Trace object will be displayed in the ICM workspace.• 

6.2�Multi-Windows

To display more than one window click on the buttons shown below.
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To control the layout and mouse sync mode click on the button shown
below.

6.3�Meshes - Surface - Grobs

Available in the following product(s): ICM-Browser-Pro | ICM-Pro

Click on the tab button entitled ’meshes’ and more graphics tools for
surfaces are available. In ICM surfaces are sometimes referred to as
meshes or graphical objects (Grobs).
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Surface Plain Solid

6.3.1�Surfaces

The surface of your structure can be displayed and colored by
electrostatics or binding properties. To do this:

Load a structure into ICM File/Open or tab-pdb{PDB Search}• 
Convert the structure into an ICM object.• 
Select the ’meshes’ tab button.• 
Click on the drop down arrow menu shown below and select which
surface you wish to generate.

• 

Click on the generate surface button next to the drop down arrow.• 

6.3.2�MolSkin
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MolSkin is a new macro that instantly makes publication quality graphics
and it gives each molecule a color and colors contact patches. It
undertakes the following:

Molecular surfaces are generated with those assigned colors and
occlusion shaded.

• 

Carbons of each molecule are colored by its own consistent color.• 
Labels, ribbons, are colored accordingly.• 
Surfaces are gradually cross-colored by each other to mark the
contact patches.

• 

The labels are brought to the surfaces.• 

To use MolSkin:

Right click on the object in the ICM workspace and choose
Shapes/Make/Molecular Shapes and Contacts.

• 

Once the surfaces are made they will be listed in the ICM
workspace where they can be toggled on or off.

• 

6.3.3�Color Surface by Proximity

To color a surface by proximity to neighboring molecules:

Make a surface.• 
Right click on the molecule you want to color by proximity and
choose Shapes/Make/Color by Proximity.

• 

6.3.4�Color Surface by Selection

To color a surface by a selection:

Make a surface.• 
Make a selection.• 
Right click on the molecule you want to color by selection and
choose Shapes/Make/Color by Selection.

• 
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6.3.5�Meshes

A variety of shapes can be constructed automatically using ICM. These
shapes are referred to as meshes. The types of shapes you can build are
shown in the drop down option in the meshesh tab

To make a shape select it from the menu by clicking on the down arrow
and then click the button next to the menu. The shape will then be
displayed in the 3D graphics window.

6.3.6�Google 3D Objects (Sketchup)

To read in a 3D Mesh from Google in KMZ or COLLADA format:

File/Load/ 3D Mesh in KMZ or COLLADA Format from Google• 
Search for the object you would like to view and download it.• 
To read the file go to File/Open• 

6.3.7�Display or Undisplay Meshes or Surfaces

To display or undisplay the surface click in the box in the ICM
workspace as shown below:

NOTE: All surfaces, meshes and macroshapes come under the one heading
of meshes in the workspace panel.
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6.3.8�Mesh Options.

A number of options relating to meshes can be found by right clicking on
the mesh in the ICM Workspace. This section describes some of these
options.

6.3.8.1�Resize Mesh

Once a mesh has been created you can move it and resize it. To do this:

Locate the mesh in the ICM Workspace and right click on it• 
Select the Resize/Move Mode in the menu.• 
A purple box as shown below will surround the molecule.• 

To resize the mesh click on one of the corners of the box and drag to
the required size. The number displayed on the edges of the box
represent the dimensions.
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6.3.8.2�Move Mesh

To move a mesh:

Locate the mesh in the ICM Workspace and right click on it• 
Select the Resize/Move Mode in the menu.• 
Click on the mesh in the graphical display with the middle mouse
button.

• 

6.3.8.3�Mesh Representation

There are five different display modes:

Dot• 
Wire• 
Solid Rugged• 
Solid Smooth• 
Smooth Transparent.• 
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6.3.8.4�Mesh Color and Lighting

There are a number of options to color and change the display of the
mesh. These options can be accessed simply by right clicking on the mesh
name in the ICM Workspace as shown below.

6.3.9�Mesh Clipping

Clipping tools can be used to adjust the frames of the mesh
independently of other objects.

The buttons shown below can be used for this purpose.

The buttons used for clipping are described in the section entitled
Clipping Tools.

To clip the skin independently of the object as shown in the image
above:

Display object and mesh.• 
Click and hold on clip meshes button(red button) and select Reset
Clipping to Default and check the option Clipping enabled

• 

Click on the front clipping plane button.• 
(Optional) To lock the mesh clipping click on the yellow lock mesh
clipping button.

• 

6.3.10�Save Mesh

You can save a mesh as a wavefront object by right clicking on the mesh
in the ICM Workspace and selecting SaveAs.

6.3.11�Occlusion Shading

The occulusion shading option provides better representation of depth
within a cavity. The color of each surface element of a grob (mesh) is
changed by mixing its own color with the background depending on the
burial of the surface element.

To add occlusion shading:

Right click on the mesh in the ICM Workspace and select Occlusion
Shading. The occlusion shading value can also be changed before
generating the mesh in the meshes tab.

• 

Enter a depth value - default is 0.8. Higher values will generate
a more dramatic shading.

• 

See example here.
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6.4�Coloring

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

To change the coloring of molecules:

Select the atoms, residues, molecules, or objects you wish to
color in the graphical display or in the ICM Workspace.

• 

Then use the color options in the Display Tab.• 

6.4.1�Coloring

To change the color of a structural representation such as CPK, Xstick,
wire or ribbon.

Select the atoms, residues, molecules, or objects you wish to
color.

• 

Click and hold on the structural representation button for the
representation you wish to color (e.g. wire, ribbon etc...) in the
Display tab.

• 

Select a color by clicking color.• 

To color by a particular parameter such as atom type, b-factor,
secondary structure etc...

Click and hold on the structural representation button for the
representation you wish to color (e.g. wire, ribbon etc...) in the
Display tab.

• 

Select ..by-> option• 

To change the color of everything displayed :
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Click on the color palette in the Display Tab.

6.4.2�Color Background

To change the color of the background:

Select View/Color background.• 

Click on the square of your desired color. If you are not
satisfied with the color palate, click on the arrow next to the
colors to customize a color.

• 

OR

Right click on a color in the colors panel in the display tab.• 

6.4.3�Background Image

A background image can be added to the graphical display. This can be
useful for making cool images or for comparing structures (e.g.compare
displayed object with background image of object).

To add a background image from an image file (png or jpeg):

File/Open Image• 
Right click on the image in the ICM Workspace and select "Set as
Background in Graphics."

• 

Choose one of the following: (1) Original Resoution, (2) Original
Resolution Centered, or (3) Scale to Fit

• 

Enter the Scale (%)• 
Enter whether you want to keep existing background.• 

To move and resize a background image: Version 3.7-2b and higher.

File/Open Image• 
Right click on the image in the ICM Workspace and select "Set as
Background in Graphics."

• 

Choose the option Original Resoution.• 
Click on the drag atom button (looks like a hand).• 
Click and drag image.• 
Remember to deselect drag atom button.• 
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To set current display as background image:

Click and hold on the "Copy Image to Clipboard" button at the
bottom of the gui and select the "Set as Background" option.

• 

To remove a background image:

Select the display tab and then click and hold on the color sphere
button and select "Remove Background Image".

• 
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OR

Right click on the image in the ICM Workspace and select "Set as
Background in Graphics."

• 

Choose the option Remove From Background• 

6.5�Lighting

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

These options are in the light tab

CLick and drag the sliders to change the lighting. You can also save
your preferred lighting settings and return to default.

Shine - shininess property of the solid material

Ambient - ambient light intensity of RGB for ambient light

Diffuse - diffuse light intensity of RGB for diffuse light

Spec - specular light intensity of RGB for specular light

Alpha - transparency setting for grob

A-Bright - light intensity shinning on grob

X and Y - Change the position of the light source in the graphics window

6.6�3D Stereo

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

Click and hold on the stereo hardware button (see image below).

There are 5 different options available which are described here
http://molsoft.com/man/icm-table.html#GRAPHICS.stereoMode .

6.5�Lighting 117



up-and-down1. 
line interleaved2. 
in-a-window3. 
Sharp4. 
Anaglyph5. 

The Anaglyph option is the easiest to used with inexpensive 3D glasses
and and without any expensive 3D compatible hardware or monitors. The 3D
effect is better with a lighter background.

6.7�3D Printing

You can save surfaces in the STL format for 3D printing. To do this:

Make a mesh e.g. go to the meshes tab - plain solid.• 
The mesh (surface) will then be displayed in the ICM workspace
(left hand side).

• 

Right click on the mesh and choose Save as.. and choose stl from
the format option list

• 

6.8�Labeling and Annotation

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

To add labels or display or undisplay pre-defined annotation:

Select the atoms, residues, molecules, or objects you wish to
label in the graphical display or in the ICM Workspace.

• 

Then use the label options in the Display Tab.• 

To add new user-defined annotation:

Select the atoms, residues, molecules, or objects you wish to
label in the graphical display or in the ICM Workspace.

• 

Right click on the selection and choose "Annotate Selection".• 

6.8.1�Labeling

Labeling options are contained within the Labels or Display Tab. In many
cases clicking and holding a label button will allow you to view more
options.
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6.8.2�Labeling Atoms

Select the atoms you wish to label (see display structure or selection
toolbar).

Select the display tab.• 
Click the label ATOM button.• 

To change the level of label detail:

Click and hold the label ATOM button and select the desired level
of label detail, color or style.

• 

6.8.3�Labeling Residues

To label residues:

Select the display tab.• 
Select the residues you wish to label (see display structure or
selection toolbar).

• 

Click the label RES button.• 
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To change the level of label detail:

Click and hold the label RES button and select the desired level
of label detail or style.

• 

6.8.4�Move Residue Label

To change the location of your residue label:

Select View/Drag res labels.• 
If your mouse has a middle mouse button, then click on handle (as
shown) of the label you wish to move, and drag it to your desired
area.

• 

If your mouse has no middle mouse button, then click on the
Translation icon on the toolbar, and click on the handle (as
shown) of the label you wish to move, and drag it to your desired
area.

• 

The +/- buttons on the side of the Residue and Atom buttons will shift
the label. There are also other residue label move options available
when you click and hold the residue label button. These options include
Shift to Sidechain Tips, Shift to Calphas, and Restore Positions

6.8.5�Label Variables

To label variable angles (dihedral-torsion, planar and phase angle) the
molecule needs to be converted into an ICM object.

Convert the molecle to an ICM object.• 
Select the atoms for which you would like to display the variables
(see display structure or selection toolbar).

• 
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Click on the toggle variable label button shown above located in
the display tab.

• 

Change the font size by using the +/- buttons.• 
Change the font and color by clicking and holding on the variable
atom label button.

• 

To change the variable label style click and hold the variable atom
label button as shown below.

Rings of varying diameter and color are superimiposed on rotatable
bonds. Green rings with large diameter are considered less constrained
than rings with small green rings. Red rings are highly constrained.
When the Label Style/Energy option is selected the first number
displayed represents the bond angle, the second the energy and the third
the worst energy that could be achieved by rotating the bond.

6.8.6�Sites and Annotation
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When a PDB file is read into ICM the sequence functional/mutation sites
listed in Uniprot are automatically displayed. To undisplay all
displayed sites click on the Sites button in the display tab. Click in
the bottom left hand corner of the annotated site to change the level
of detail or click on an arrow head to move the location.

122 6.8.6�Sites and Annotation



Individual sites can be displayed or undisplayed in the ICM workspace.

To create your own annotated site:

Select the region you wish to annotate as a Site.• 
Right click on the selection.• 
Choose the option Annotate/Make Site• 
Enter the annotation into the text box and select ok• 
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Your new site will now be listed in the ICM Workspace.

To edit or delete a site:

Right click on the site in the ICM workspace.• 
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6.8.7�Changing Label Colors

To change the color of any label:

Click and hold down the required label button and a menu as shown
below will be displayed.

• 

Select color.• 

6.8.8�Customized Label 2D or 3D

To generate a customized a label:

Select the labels tab.• 
Select either 2D or 3D button.• 
Enter your label and select the desired color, font and size.• 

To edit or delete a label - right click on the label in the graphical
display as shown below.
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To move a custom 3D label you need to right click on it in the ICM
workspace (under meshes) and choose Connect/Move independently. Press
the Esc key to disconnect when you have finished moving it.

6.8.9�Undisplay Customized Label

Undisplay Residue, Atom, and Variable Label Any label that is displayed
can be undisplayed by selecting the region of the molecule related to
the label and clicking on the corresponding label button in the labels
tab. For example if you wish to undisplay an atom label - click the atom
label button. If a label is displayed the coresponding button in the
display tab will be shaded blue. When you delete the button will return
to grey. 2D and 3D labels have an undisplay button (red cross on the
button see customized label section).

Undisplay 2D or 3D label Click onthe undisplay label button in labels
tab.

NOTE: A label can also be deleted by right clicking on the label in
the graphical display and selecting delete.

6.8.10�Labeling Distances

Within the labels tab there are tools for calculating and displaying
distances. These tools can also be found in the Tools/Analysis menu.
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To display distance between two atoms:

Click on the labels tab (previously called advanced tab).• 
Select the atoms between which you would like to find the
distance. (See selection toolbar)

• 

Click on the ’Show Distances Between Two Atoms’ Button• 
The distance will be displayed in angstroms, in green.• 

To find the distance from one atom to many:

Click on the labels tab (previously called advanced tab).• 
Select the atom from which you wish to measure the distance from
(See selection toolbar)

• 

Click on the ’Show Distances From One Atom To Many’ button.• 
The distances will be displayed in green.• 

The maximal and minimal distances can be selected by entering values in
the boxes shown here (below) in the labels tab (previously called
Advanced tab).

NOTE: Distances can be displayed and undisplayed in the 3D labels
section of the ICM Workspace. See image below.
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To change the color of the distance label

Right click on the distpairs under the 3D labels section of the
ICM workspace and select Change Color.

• 

6.8.11�(Un)display Origin

To display and undisplay the axis of the coordinate frame (origin):

Select the labels tab and select the toggle origin button.• 

6.9�Display Distances and Angles

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro
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6.9.1�Display Distance Between Two Atoms - the
quick way

Click on the Display tab• 
Click on the Distance between two atoms button shown below.• 
Click on the atoms you wish to measure.• 
Distance will be displayed in the graphical display. You can turn
this on and off in the ICM Workspace panel under the heading 3D
labels.

• 

6.9.2�Display Planar Angle

Select the display tab.• 
Select three atoms.• 
Select the button shown below.• 

6.9.3�Display Dihedral Angle

Select the display tab.• 
Select four atoms.• 
Select the button shown below.• 

6.9.4�Delete Label

To delete distance or angle labels

Select the display tab.• 
Select the delete distance or angle label button shown below.• 

6.10�Graphics Effects
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Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

All the visual effects tools can be accesed by the View Menu or click on
the corresponding button in the View Tools panel shown below.

6.10.1�Fog

Fog Toggle(Ctrl + D) : this feature creates a fog-like environment for
your object, so that the part of your structure that is closer appears
clear and the distant parts are faded as if they are in fog. The
clipping planes control the point at which the fog begins.

View/Fog• 

6.10.2�Sketch Accents

To make images as shown below use:

View/Sketch Accents• 

6.10.3�Elegant Ribbon & Ligand Sketch

Display Tab• 
Click and hold Hydrogen button• 
Select Elegant Ribbon+Sketch• 
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6.10.4�Occlusion Shading

Occlusion shading is for surfaces and meshes to give a perception of
depth.

To add occlusion shading:

Right click on the mesh in the ICM Workspace and select Occlusion
Shading. The occlusion shading value can also be changed before
generating the mesh in the meshes tab.

• 

Enter a depth value - default is 0.8. Higher values will generate
a more dramatic shading.

• 

6.10.5�Perspective

Toggle perspective Ctrl_P this will add perspective to your structure,
enhancing depth in the graphical display.

View/Perspective• 

6.10.6�Animate View

Learn how to build fully interactive and interruptable animations.

6.10.6.1�Make Animation

To quickly produce an ICM Molecular Animation:

Click and hold down the "Begin rocking/rotation" button shown in
the picture below.

• 

Choose from the following options - X-Rock, Y-Rock, Xy-Rock,
xY-Rock, X-Rotate, and Y-Rotate.

• 
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NOTE: Default rocking representation can be changed in the
File/Preferences/Gui menu.

6.10.6.2�Change Speed, Range and Cycle Length of
Animation

To change the speed, range and cycle length of the animation:

Click and hold down the "Begin rocking/rotation" button shown in
the picture above.

• 

Choose the set speed range option and change the speed and range
using the drag bars. Any change will appear in the graphical
display behind this box.

• 

If desired you can change the number of cycles of the animation.
This is an ideal tool for screen-shot movie making.

• 

NOTE: There is a return to default button in the Rocking Preferences
dialog box shown above and defaut values can be changed in
File/Preferences/Gui.

NOTE: Default rocking speed can be changed in the
File/Preferences/Gui menu.

6.10.6.3�Interrupt Animation

An ICM Animation or Transition is fully interactive and is interrupted
by a single click of the mouse.

To stop or change an animation or transition:

Click the "Begin rocking/rotation" button shown in the picture
below.

• 

To temporarily halt an animation or transition:
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Click in the graphical display. Once you release the mouse button
the animation will start again.

• 

NOTE: If you click on the graphical display during an animation the
animation will be interrupted. Whilst clicking and holding the mouse
button other operations can be performed such as zooming and
selections.

6.10.6.4�Saving an Animation

An animation can be saved in an ICM project:

File/Save Project

Or

as a slide.

6.11�Graphics Shortcuts

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

The left mouse button can be mapped onto different graphics tools which
can be selected from the right hand tool bar.

Note: (1) You can access many non-rotation modes directly from the
rotation mode by using Middle and Right-mouse buttons, as well as by
using the right, top and left margins of the graphics window. (2) You
can access the rotation mode from non-rotation modes by pressing
Ctrl.

rotation ( the default , press Ctrl if you in the non-rotation
modes )

• 

translation ( the middle mouse button in the rotation mode)• 
zooming in and out by dragging the mouse up and down (the left
margin in the rotation mode, or use the mouse wheel)

• 

Z-rotation ( the top margin in the rotation mode)• 
selecting by box ( the right mouse click in the rotation mode )• 
selecting by lasso ( Ctrl-draw lasso in the rotation mode )• 
picking out atoms ( a toggle )• 
picking out and labeling residues (a toggle)• 
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moving the front clipping plane ( the top section of the right
margin in the rotation mode)

• 

moving the rear clipping plane ( the bottom section of the right
margin in the rotation mode)

• 

moving the slab ( the middle section of right margin in the
rotation mode)

• 

unclipping ( Ctrl-U )• 
rotating torsions (Ctrl-left-mouse-click in the rotation mode)• 
connect and unconnect separate molecules to movement controls• 

Many useful graphics tips are summarized here.

NOTE: Key mouse controls are summarized in the command line manual
here http://www.molsoft.com/man/graphics-controls.html

6.12�Molecule Move Buttons

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

To move your structure it must first be displayed in the graphics window
(for instructions on how to display a structure see the Display Tab).
All of the following options are displayed in the Move Tools toolbar
(shown below).

6.12.1�Rotation

In order to achieve the best pose for a picture or to enable the study
of a certain region of your structure in more detail you may need to
rotate the structure:

Click on the rotation icon on the toolbar.• 

Click and drag on your structure in the display window until it is
in the desired position.

• 

6.12.2�Custom Rotation

An option is provided to customize the rotation of the molecule. This
allows exact rotation by a specified number of degrees.

134 6.11�Graphics Shortcuts



Click and hold down the rotation button and a data entry box as
shown below will be displayed.

• 

Enter the number of degrees of rotation you require and in which
X, Y or Z coordinate.

• 

To continuously rotate the picture:

Click on the continuous rotation icon on the toolbar.• 
Click, hold, and slightly move your mouse anywhere on the
graphical display window. The point at which you hold your mouse,
is the direction to which the object will turn.

• 

Positioning the mouse towards the center of the display will move
the object slower than if the mouse is positioned towards the edge
of the graphical display.

• 

In order to rotate your picture around the Z-axis:

Click on the Z-axis rotation icon on the toolbar.• 

Click and drag your object around the Z-axis until it is in the
desired position.

• 

6.12.3�Translation

To translate your structure up, down, left, or right:

Click on the translation icon on the toolbar.• 
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Click and drag on your structure in the display window until it is
in the desired position.

• 

When you are displaying more than one object and you wish to translate
one object in relation to the other on the Z-axis:

Right click on the name of the object you wish to move in the ICM
workspace and select connect to object. This object is now
independent from the other object and can now be manipulated
separately.

• 

Click on the Z translate icon on the toolbar.• 
Click and drag your structure along the Z-axis, moving it closer
or further from your unconnected structure.

• 

Once you are finished, right click on the name of the object which
is connected, and click on disconnect.

• 

6.12.4�Zoom

To zoom in or out of your structure:

Click on the zoom icon on the toolbar.• 

Click and drag your mouse up to zoom in and down to zoom out.• 

You can also zoom in and out directly with the right-mouse-button
without explicitly switching to the zoom tool, if you use the left
5%-margin of the graphics window.

6.12.5�Center

To restore your picture to the center of the graphical display window or
to center on a selection:

Make a selection of the region you wish to zoom into - if no
selection is made the whole structure will be centered.

• 

Click on the center icon on the toolbar.• 
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6.12.6�Torsion Angles

To alter the torsion angle of certain residues of your structure
manually:

Convert your pdb structure into an ICM object.• 
Click on the change torsion angles icon on the toolbar (see image
below).

• 

Click on the bond until you see the torsion angle displayed in
yellow (see image below). Click and hold on the bond around which
you wish to rotate a residue. The changing torsion angle will be
displayed in orange.

• 

NOTE: This option can be used more effectively in conjunction with
the variable label option.

To alter torsions by entering specific angle values:

You can edit torsions by specifically defining the exact angle as
described here.

• 

6.12.7�Connect (Move)

When there is more than one object displayed in the graphical display
window the objects are connected to one another. If you wish to move or
manipulate one object independently from the others you need to connect
to it

To do this from the ICM Workspace:

Right click on the name of the object you wish to move in the ICM
workspace and select Connect to Object. The object will now be
colored yellow.

• 
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The object is now controlled separately from the rest of your
objects by your mouse.

• 

Disconnect your object by once again right clicking on the name of
the object in the ICM Workspace and selecting disconnect in the
drop down menu or Press the ESCAPE key.

• 

Note: you can temporarily switch to the global rotation in the
connected state if you press Shift

Note: use the Escape button to disconnect

6.13�Clipping Tools

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

The clipping tools allow you to adjust the frames of the ICM window,
changing the clipping planes.

Clipping planes can also be moved without switching to the clipping
tool, if you click the right hand margin of the graphics window:

The top section of the right 5% margin of the graphics window:
moves the back clipping plane

• 

The middle section of the right 5% margin of the graphics window:
moves the slab (both clipping planes)

• 

The bottom section of the right 5% margin of the graphics window:
moves the front clipping plane

• 

In order to move the front or rear clipping planes of your screen:

Click on the Move front clipping plane or Move rear clipping plane
icons on the toolbar.

• 

Click and drag the respective plane frontward or backward,
depending on how you wish to clip it.

• 

You can also move the slab of viewing window, keeping the distance
between the front and back clipping planes. In order to adjust the area
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of the structure where your viewing window is located:

Click on the Slab icon on the toolbar.• 
Click and drag the slab frontward or backward, depending on the
desired area of the structure you wish to see.

• 

If you have made changes to the clipping planes which you do not wish to
keep or you wish to automatically fit your entire structure within the
clipping planes:

Click on the Unclip icon on the toolbar. This will automatically
set the clipping planes to fit your object.

• 

6.13.1�Mesh Clipping

Clipping tools can be used to adjust the frames of the mesh
independently of other objects. This is described here.

6.14�Graphic Layers

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

To display and undisplay layers of a structure you can use the buttons
shown below. Seven layers can be created and within each layer different
structural representations can be displayed.

Right click on one of the layer buttons and a number of options can be
chosen as shown below.

To change the display in one of the layers:

Right click on one of the layer buttons.• 
Select a representation wire, xstick or CPK.• 
You can do this for each of the seven layer buttons.• 
Click on the layer button to display and undisplay. If the layer
button is shaded red then the layer is not displayed. If the layer
button is shaded light blue then it is displayed. You can switch
between layers by clicking on the button or using the. You can use
the memorize button to store a particular representation and clear
to remove a memorized representation.

• 

6.15�High Quality Publication Images
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Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

6.15.1�High Quality Image

To make high quality publication images:

The first step is to improve the quality of the image using the High
Quality Image and Antialias buttons shown below.

To save and write an image:

Select File/Write Image and the following window will be
displayed:

• 

Choose one of the tabs depending on the image type you require:

Antialiasing allows you to make png, tif, targa, eps or rgb file
types.

• 

High Resolution PNG Allows you to specify a resolution increase
and transparent backgroun.

• 

High Resolution Allows you to specify a resolution increase for
tif, targa and rgb files.

• 

Vectorized Postscript This creates a vectorized postscript model
of the screen image. Instead of the bitmap snapshot this command
generates lines, solid triangles and text strings corresponding to
the displayed objects. Since the postscript language is directly
interpreted by high-end printers, the printed image may be even
higher quality than the displayed image. The final resolution is
limited only by the printer since the original image is not
pixelized. Warning: there may be inevitable side-effects for some
types of solid images at the intersection lines of solid surfaces
(i.e. large scale cpk representation, hint: use display skin
instead).

• 
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**NOTE: With some graphics drivers the high resolution image may be
distorted or multiple representations of the image in one frame.
Please see the FAQs for a solution to this.

6.15.2�Quick Image

A quick image can be saved using this option. The image will be saved as
icm1.png in the current directory in which you are working. Each
subsequent image produced will be incrementally numbered.

This option is also available via a button as shown below:

6.15.3�Image Options

Click and hold on the image button at the bottom of the GUI to:

Copy image to clipboard (single click on the button also does
this).

• 

Resize image (Write Image Advanced)• 
Transparent Background Write Image Advanced)• 
Store an image in ICM (Write Image Advanced)• 
If you are making an ICM document you may want to store images
inside ICM (Add Image to Album).

• 
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7�Slides & ActiveICM
In this chapter you will find a
description of the tools available
to create files (.icb) containing
fully-interactive three-dimensional
(3D) molecules and two-dimensional
(2D) data. These files can contain
multiple interactive views and
animations of molecular structures
and objects in conjunction with
related hyperlinked text, chemical,
biological sequence, alignment and
data views. The files are small and
easily transferable and
downloadable. The files can be used

for Molecular Presentation and Documents inside the ICM browser or
displayed on the web and in PowerPoint using the ActiveICM plugin. For
examples of ICM Molecular Documents please see MolSoft’s ActiveICM
product page at www.molsoft.com/activeicm.html

Chapter Contents:

Making Molecular Slides• 
How to View and Navigate Slides• 
How to Edit Slides• 
How to Add Smooth Blending and Transition Effects Between Slides• 
How to Make Molecular Documents - Link HTML Text to Slides• 
ActiveICM - ActiveICM enables you to view and display ICM
graphical slides and animations interactively inside Windows
Microsoft PowerPoint and web browsers such as Internet Exporler
and Mozilla Firefox.

• 

IcmJs is a JavaScript/HTML5 version of the ActiveICM plugin.• 

7.1�Making Slides

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

A slide enables you you to store a large number of different 3D
visualization along with text and window layout.The following
information can be stored in a slide:

Viewpoint (e.g. rotation, translation, zoom, lighting and depth
effects)

• 

A set of atom-specific graphical representations such as surfaces,
which can be represented as smooth, transparent or wireframe,
ball-and-stick models, CPK (space-filling) models.

• 

A set of atom, residue or distance labels on any of the atomic
items

• 

A set of arbitrary 3D textual annotations assigned to a point in
space

• 

A set of arbitrary 2D annotations assigned to specific 2D
coordinates on a screen

• 

Parameters of the parametric animation• 
Window layout - for when the slides are viewed in the browser.• 
Current table(s)• 
Sequences and Alignments• 
HTML text with hyperlinks• 
2D images• 
For each grob (mesh): representation and colors.• 

A slide can be made by clicking on the Camera button at the bottom of
the GUI.
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Slides can be viewed in the GUI, can be edited and graphical effects can
be added to them. Slides can also be embedded into the web, or
PowerPoint using ActiveICM or viewed in ICM-Browser (or ICM-Pro).

This tutorial takes you through the steps to create a series of fully
interactive 3D slides. Another tutorial can be found here. To begin
making ICM Molecular Slides:

First load the structure or structures you wish to display in your
first slide. Additional structures, labels etc and text can be
added at any point during the slide making process. In this
example we will load the PDB file 1XWS a PIM1 kinase.

• 
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Next, we will convert the PDB file to an ICM object so we can make
slides of the ligand-receptor hydrogen bonds and binding pocket
surface.

• 

Now we are going to prepare the first slide by rotating the
protein structure to an orientation which allows the viewer to see

• 

7.1�Making Slides 145



the key features of the kinase. For example the bulge in the hinge
region (between the N- and C- lobes) which is unique to PIM
proteins.

Next, make the first slide by clicking on the camera button at the
bottom of the graphical user interface.

• 
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Once you have clicked on the camera button you will see that the
first slide has been generated. The first slide is shown in the
ICM Workspace window as shown below.

• 

Slides can consist of Static views or Transitions and Animations.
Here we will zoom into the flexible glycine rich region of the
kinase which lays across the roof of the ATP-binding pocket. Click
on the camera button and make the second slide

• 
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Next, we will make a slide of the surface of the ligand binding
pocket colored by binding property.

• 

Now save the document as an icb file. Go to File/Save as...• 
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7.2�Make a Movie from a Set of Slides

Available in the following product(s): ICM-Browser-Pro | ICM-Pro

Please see the movie chapter on how to make a movie from a set of
slides.

7.3�How to View and Navigate Slides

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

7.3.1�View Slide Show

To view a slide show select the buttons shown below:

NOTE: Slides are associated with the objects currently loaded into
ICM. Therefore if you delete an object then the slides will not work.
However if you delete an object and then re-read the same object with
the same name and structure the slides will be ok.

To save a slide show

File/Save Project• 

7.3.2�Slide Navigation

You can make as many slides as you wish as described in the Making
Molecular Slides section.

To navigate through the slides you can use the buttons shown below, the
cursor keys for some operations or the right click options in the ICM
Workspace.
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The slide currently displayed is highlighted in red in the ICM
Workspace.

To jump to another slide right click and select "Set Slide".

All slides are displayed in the ICM Workspace. You can hover the mouse
over a slide name in the ICM Workspace and a thumbnail sketch of the
slide is displayed as shown below. This can be used for slide navigation
purposes.

Or you can right click on the name of the slide in the ICM Workspace and
select the option "Preview".
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7.4�How to Edit Slides

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

You can jump to the slide you wish to edit by following the slide
navigation instructions.

7.4.1�Edit Slide

Edit slide contents: To edit the content of a slide the procedure is to
add a new slide and then delete the old one or use the "overwrite
current slide" option as shown below:

Click and hold down on the camera button.• 

To edit a slide description.

Click and hold down on the camera button and select the option
"Edit Slide Description".

• 
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Enter the name of the slide• 
Enter a description of the slide.• 
If you wish to keep the current window layout or active tabs check
the boxes provided

• 

To delete a slide:

Right click on the name of the slide in the ICM Workspace and
select Delete.

• 

To change the name of a slide

Right click on the name of the slide in the ICM Workspace and
select Edit Slide.

• 

7.4.2�Move Slide

To change the slide’s position in the slideshow use the Move Current
Slide option and select the new position from the list.

Click and hold on the "make slide button".• 
Select Move Current Slide.• 
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Select the position in the slide show where you want to move the
slide to.

• 

Co-display more than one slide

Right click on the name of the slide in the ICM Workspace you wish
to co-display with the curently displayed slide.

• 

Select the option co-display slide.• 

7.5�How to Add Smooth Blending and
Transition Effects Between Slides

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

How to add smooth and blend transitions to a slide.

Right click on the name of the slide in the ICM Workspace.• 
Select Edit Slide.• 
Select the desired transition effect - smooth or blend as shown
below.

• 

Select the length of the transition in milli seconds.• 
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7.6�How to Make Molecular Documents -
Link HTML Text to Slides

Available in the following product(s): ICM-Browser | ICM-Browser-Pro
| ICM-Pro

An ICM Molecular Document contains text and images which can be
hyperlinked to the graphical display. Click on the hyperlinked text and
then a fully-interactive 3D slide will be displayed. The hyperlinks are
usually linked to a set of slides but can also be linked to a series of
commands in a script, a web page, a table or alignment. Once a molecular
document has been made you can view it in the ICM-Browser (File/Save
Project .icb file) or download ActiveICM and view it in a web page or
Powerpoint.

To begin creating an ICM document

File/New/ and click on the HTML tab.• 
Enter some text. E.g the Name of the HTML document. Formatting can
be changed as described in the edit section below.

• 

Click OK• 

A HTML text panel will be displayed in the graphical user
interface.

• 

NOTE: You can add multiple documents into a single file. The
documents will be accessible via tabs at the top of the HTML panel.

7.6.1�How to Add Text or Edit a Molecular
Document
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To edit the HTML text in the graphical display

First create an HTML document and the text panel will be displayed
in the graphical user interface.

• 

Right click in the body of the text display panel and select Edit.• 

Enter text and use the formatting tools provided in the panel
above the text editor. Make sure you have selected the Edit tab in
the HTML editor. You can see your page in the View tab or write
directly in HTML in the Source tab.

• 
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The key formatting tools in the HTML editor are shown below.
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7.6.2�How to Make a Hyperlink Between Text and a
Slide

To make a hyperlink between the text and the graphical display (slide)

Make a slide or set of slides of the graphical display you wish to link
to. See Making Molecular Slides for help on this.Once slides have been
created:

File/New/Html• 
Right click in the body of the text display panel.• 
Select Edit.• 
Highlight the text you wish to link to a graphical display - you
can do this by left clicking and dragging over the text (selected
text will be highlighted in blue).

• 

Click on the "Camera button" in the HTML editor formatting tool
panel.

• 

Select the Slide tab.• 
Select which number slide you wish the text to be linked to from
the drop down menu.

• 

There is an option to display the slide as a thumbnail image in
the text document panel. Check if appropriate.

• 

7.6.3�Insert Image

NOTE: The easiest way to add images (PNG or JPEG) into an ICM
Document is to use drag and drop. You can drag and drop the image
into the ICM Workspace or go to File/Open. Once the image is in the
album in the ICM Workspace you can then drag it from the ICM
workspace into tthe HTML editor.
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Another way to insert a picture into the HTML text panel

First read the image into the ICM photo album File/Open OR Drag
and Drop from directory into the ICM Workspace.

• 

The image name and preview will then be displayed in the ICM Workspace.

Create HTML text - File/New/HTML. Add text.• 
Right click in the HTML window and select ’Edit Source’.• 
Right click on the position in the ICM Script Editor where you
would like to insert the image.

• 

Select ’Insert Image’• 

Select the image name source.• 
Choose the desired Width and Height.• 
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Click OK.• 
Click Save in the ICM Script Editor.• 

7.6.4�Insert Script

How to insert a script to the text panel

There are 3 ways to add a script - described in more detail below

1. Drag and drop script from ICM Workspace

2. In the HTML Source Editor - right click and select Insert Slide or
Action

3. Create an "inline" script

These methods are described below:

Drag and Drop Method

Create a script File/New/Script• 
The script will be displayed in the ICM Workspace.• 
Right click in the HTML Text Panel (for instructions on how to
create this panel see create molecular document) and select edit
source and the HTML Source Editor will be displayed.

• 

Click-Drag and Drop the script into the HTML Source Editor• 

A line as shown below will be added.

<a href="#icm/script/script1">text placed here will be displayed as a link in the document</a>

Another way to add a script to the document is to Insert Action:

Right click in the body of the text display panel.• 
Select Edit Source• 
Highlight the text you wish to link to a graphical display - you
can do this by left clicking and dragging over the text (selected
text will be highlighted in blue).

• 

Right click and select ’Insert Slide or Action’ or select the
button in the HTML Source Editor and a window as shown below will
be displayed.

• 
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Select the option [Arguments and] ICM commands• 
Add script in the editor provided• 
Select ok• 

Inline Script

A script can be added to the HTML text in the following way

Right click in the body of the text display panel.• 
Select Edit Source• 
Enter script in the format as shown below.• 

<!--icmscript name="script2"
#dialog{"Test"}
# i_number1 (2)
# i_number2 (3)
print $1 + $2
--><a name="script2" href="#_">script2</a>

7.6.5�Insert a Dialog Box

Dialog boxes are provided to enable a viewer to interact with a
presentation or document file. The dialog box will be a gui data entry
box. For an example here is a script to prompt the user of the file to
enter a pdb code:

#dialog{"Read PDB File"}
# s_pdbcode (1crn)
read pdb $1 
ds a_1.

160 7.6.5�Insert a Dialog Box



The code above can be saved as a script or inside the html text. To do
this:

Right click on the HTML text display and select "Edit Source".1. 
Highlight the text you wish to link to a dialog box and then
select the right click and select ’Insert Slide or Action’ or
select the button in the HTML Source Editor and a window as shown
below will be displayed.

2. 

OR.

Right click on the HTML text display and select "Edit Source".1. 
Add a link to a script as shown below.2. 

<a href="#icm/script/script1">Example Script 2</a> 

7.6.6�How to add a check box.

To add a check box:

Click on the check box button in the HTML editor tools panel (see
below).

• 

You can choose the check box to toggle an object or molecule on or
off. Or you can be more specific about the toggle actions using
the ICM command line. You can choose different actions for On and

• 
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Off.

7.6.7�Document Navigation

The following buttons shown below aid document navigation. Also remember
that more than one document can be stored and the header of each
document file will be displayed in multiple tabs in the text panel
window.

7.6.8�Protect Shell Objects From Deletion

When making a molecular document you can protect objects from deletion
by the person who reads your document by:

Right click on the object in the ICM Workspace.• 
Select the Protect option.• 

7.7�ActiveICM
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ActiveICM enables you to view and
display ICM graphical slides and animations interactively inside Windows
Microsoft PowerPoint and web browsers such as Internet Exporler and
Mozilla Firefox.

Chapter Contents:

How to Embed in Microsoft PowerPoint 2003• 
How to Embed in Microsoft PowerPoint 2007• 
How to Embed in Microsoft PowerPoint 2010• 
How to Embed in a Web Browser• 
How to Use ActiveICM in PowerPoint• 
How to Change ActiveICM Component Properties• 
Advanced use of activeICM: Macros to direct visualisation changes• 
Background Images• 

7.8�How to Embed in Microsoft PowerPoint
2003

Setup

Download ActiveICM from www.molsoft.com/support• 
Save an ICM file (.icb) containing slides. Click here to see how
to make slides.

• 

Embed icb file

Open the Insert menu from the top bar of PowerPoint and select
Object

• 

This opens up the Object dialogue. Select ActiveIcmCtlClass:• 

Click on OK. A file dialogue will then be opened. Open the ICB
file you wish to use via this dialogue. IMPORTANT: To avoid later
problems, make sure the ICB file is in the same folder as the
PowerPoint file.

• 

A low-resolution snapshot of the first slide in the ICB file will
be shown in the activeICM control you created. You can change the
shape of the control by dragging the corners of the control with

• 
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the mouse, once selected.
Right-click on the activeICM control and select the Properties
menu item

• 

Save the PowerPoint presentation• 

7.9�How to Embed in Microsoft PowerPoint
2007

Setup

Download ActiveICM from www.molsoft.com/support• 
Save an ICM file (.icb) containing slides. Click here to see how
to make slides.

• 

NOTE: Here are the instructions for ActiveICM in Microsoft Office
2007, for older versions of PowerPoint see here.

Enable the Developer Menu:

Click the Microsoft Office Button (button top left), and then
click PowerPoint Options.

• 

In the PowerPoint Options dialog box, click Popular.• 
Under Top options for working with PowerPoint, selet the Show
Developer tab in the Ribbon check box, and then click OK.

• 
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Insert ActiveICM into PowerPoint:

Select the Developer menu.• 
Select the More Controls button in the Controls field.• 
Select ActiveICMCtl Class from the list of controls and click OK.• 
Click the mouse anywhere in the white PowerPoint space and a
dialog box will be displayed asking you to select your ICM (.icb)
file.

• 

Click and drag at the corners of the image to resize the normal
way you would resize an object in PowerPoint.

• 

7.10�How to Embed in MicroSoft
PowerPoint 2010

Setup
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Download ActiveICM from www.molsoft.com/support . Please always
check you are using the latest version.

• 

Save an ICM file (.icb) containing slides. Click here to see how
to make slides.

• 

Enable the Developer Menu:

Click on the File tab, and then click Options menu.• 
Select the Customize Ribbon option and then check the Developer
option in the right hand side panel (see image below).

• 

Click on the Developer Menu.• 
IMPORTANT! Click OK and then you will see the Developer Menu in
the Ribbon at the top of PowerPoint.

• 

Select the Developer menu.• 
Select the More Controls button in the Controls field.• 
Select ActiveICMCtl Class from the list of controls and click OK.• 
Click the mouse anywhere in the white PowerPoint space and a
dialog box will be displayed asking you to select your ICM (.icb)
file.

• 

Click and drag at the corners of the image to resize the normal
way you would resize an object in PowerPoint.

• 

7.11�Embed in Web Browser

NOTE: There is now a plugin-free version using JavaScript/HTML5 - click
here for more information.

To embed in a web browser.

Download ActiveICM from here
http://www.molsoft.com/getbrowser.cgi?product=activeicm&act=list
(it is free!).

1. 
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Create an HTML page in ICM (File/New/Html).2. 
Add a series of slides.3. 
File/Export As ActiveICM Html..4. 

NOTE. There is an issue with FireFox21 because it disables the ActiveICM
plugin. The workaround at the moment is:

type about:config in the location (address) bar and press the
"Enter" key to open the about:config page, just like you open a
website by typing the URL in the location bar.

• 

if you see a warning message then you can confirm that you want to
access the about:config page.

• 

in the Search bar at the top of the about:config page type
’load_appdir_plugins’

• 

double click on the preference to set value to true• 
restart FF• 

7.12�How to Use ActiveICM in PowerPoint

**IMPORTANT There are two ways to open a presentation:

Double click on the ppt file in windows folder. (in this case
PowerPoint will set the current directory to the one which
contains the file and there should be no problems with both
relative and absolute paths)

• 

Open ppt through the "File-Open" or recent files. (in this case
PowerPoint DOES NOT SET the current directory to the one which
contains the file -> relative path might not work and user will be
prompted to locate the ICB file unless file is found in absolute
location)

• 

To view the slides you must be in Slide Show mode

Press the F5 button to start the Slide Show. In edit mode (i.e.
not presentation mode), the control is shown as a static image ï¿‰
it is not possible to interact with the ICB file. Therefore, to
prepare the presentation so that the control shows the correct
initial visualisations it is necessary to run the PowerPoint
slide(s) in presentation mode

• 

Change Slides

Use the left and right cursor keys to change slides.• 

A number of other options can be accessed by right clicking on the
slide. These options include:

Select Slide• 
Auto Play• 
Set on/off rocking• 
Center• 
Load a new ICM File• 
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You can also add multiple ActiveICM 3D displays in one slide:

To display mutliple ActiveICM 3D displays in one slide just copy
the original display or repeat the steps described above. All
powerpoint slides should point to the same ICM file (.icb) but
they can point to different slides.

• 

7.13�How to Change ActiveICM Component
Properties

A number of properties of ActiveICM can be changed once embedded in
powerpoint. The options include:
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Select the first slide to be displayed.• 
Set slide auto play.• 
Set auto play of a script.• 
Embed the powerpoint file and the icb file all into one file.• 

To change these options:

Right click on your embedded activeICM in Powerpoint.• 
Select Properties and click on the button shown below.• 

A Property Pages window will then be displayed as shown below.• 
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To change the file name of the icb file linked to activeICM: Simply type
in the path to the file or use the browse option.

To change the current ICM slide: Use the drop down button next to
Current ICM Slide to select the slide you wish to display first in your
presentation.

To auto play slides: Check the Auto Play Slides box and select the
interval between slides option. A range of slides can be played by
entering the number of the slides separated by a comma.

To auto play a script: Select whether you want the script to run On
Click or On Slide then select the script from the script to play drop
down button. You should first save your script in the icb file.

To embed the icb file in the ppt file Click the Embed File into Control
option. Important - Please save your PowerPoint file in the t 1997-2003
ppt format not pptx.

7.14�Advanced use of activeICM: Macros
to direct visualisation changes

Documentation kindly provided by Dr. Brian Marsden (SGC Oxford
http://www.sgc.ox.ac.uk/people/brian/ )

It is possible to write simple VisualBasic scripts to avoid having to
use the right-click menu approach to changing activeICM control slides
within the control itself. This allows one to place buttons outside of
the activeICM control, but in the same PowerPoint slide, which controls
the control’s behaviour. Below are a couple of useful examples of this
approach.

Creating a button to set the control’s active slide:

Insert a button Office 2003

In edit mode, make sure the control toolbox toolbar is shown by
right-clicking the blank area at the top of the top bar and
ensuring Control Toolbox is ticked.

• 
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Click on an icon in the Control Toolbox which corresponds to the
sort of button you wish to use. Then click and drag in the
PowerPoint slide to generate the button.

• 

Insert a button Office 2007:

In edit mode, click on an icon in the Developer menu or ribbon
which corresponds to the sort of button you wish to use. Then
click and drag in the PowerPoint slide to generate the button.

• 
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Double-click on the new button to open the VisualBasic editor with
two empty functions pre-defined. The first one pertains to the
control itself and can be ignored in this context *For the second
function (which is for the newly-created button), copy the
following into the editor, between the two lines of function code:

• 

ActiveIcmCtl1.currentSlide = 2

This sets the current activeICM control’s slide to be number 3
note that the value placed in this code needs to be 1 less than
the actual slide number (confusing, no?). Obviously, use a value
here that makes sense in the context of your ICB file.

• 

This should leave the editor looking like this:• 

Close the Visual Basic editor• 
To change the physical properties of the button e.g. text, colour
e.t.c.right-click on the button and select the Properties menu
option. This opens up a dialogue as below, where many properties
of the button can be changed:

• 

Using this dialogue, it should be possible to disguise the button
to look like normal text (for example) which can be clicked on
during the presentation to change the visualisation of the

• 
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control, apparently magically. Note that the button will only work
in presentation mode.
IMPORTANT: In Office 2007, remember to save the PowerPoint
presentation now as a pptm file that is, a macro-enabled
PowerPoint file otherwise the macros will not work next time you
load the presentation.

• 

Other code examples: Just copy and paste the example of interest inside
the function for the button in the Visual Basic editor. Code that
enables a button to cycle through the ICB files slides in order
(including wrap-around)

currentSlide = ActiveIcmCtl1.currentSlide
numSlides = ActiveIcmCtl1.nofSlides
If currentSlide = numSlides - 1 Then
ActiveIcmCtl1.currentSlide = 0
Else
ActiveIcmCtl1.currentSlide = currentSlide + 1
End If

7.14.1�PowerPoint Cache Errors

PowerPoint caches some information about active controls. Sometimes
after an ActiveICM upgrade you may get an error when trying to access
some property or method: "Wrong number of arguments or invalid property
assignment" or something similar.

In this case you need to close PowerPoint and remove all files from the
location below:

C:\Documents and Settings\seva\Local Settings\Temp\PPT11.0

7.15�Background Images

In ActiveICM version 1.1-5 and higher you can add background images to
your icb file and display in PowerPoint and the web using ActiveICM. The
documentation on how to insert background images can be found here.

7.16�ICM JavaScript (IcmJS)

IcmJS (formerly known as ActiveIcmJS) is a JavaScript/HTML5 version of
the ActiveICM plugin. You can read more about IcmJS here.

To make a fully interactive 3D molecular web page from ICM and embed
using IcmJS:

Use ICM vesion 3.8-5 or higher. If you do not have access to this
please contact MolSoft to request it.

• 

Make a set of slides.• 
Go to File/Export as ActiveICM Html and then select the IcmJS
check box.

• 

The IcmJS file will then be saved to your computer which you can
open in any modern browser e.g. Chrome, FireFox or Safari.

• 
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8�Tutorials

Graphics Tutorials
Molecule Representation, Coloring, Labeling
and Annotation HTML

Creating Fully Interactive Slides for
PowerPoint and the Web HTML Reference Guide |

Webinar
Sequence and Alignment Tutorials
Read Sequences and Align HTML Video
Link Sequence to Structure HTML Video
Alignment Annotation HTML
Protein Structure Tutorials
PDB Search HTML
Convert PDB to ICM Object HTML
Superimpose Proteins HTML
Structure Analysis HTML
Calculate contacts HTML
Display hydrogen bonds HTML
Identify ligand binding pockets HTML
PDB Preparation: Symmetry HTML
PDB Preparation: Occupancy & B-Factors HTML
PDB Preparation: Alternative Orientation HTML
PDB Preparation: Biomolecule HTML
Protein Modeling Tutorials
Building an Homology Model HTML
GPCR Modeling Example HTML
Loop Modeling HTML
Predicting the Effect of a Mutation on
Binding HTML

Predicting the Effect of a Mutation on
Stability HTML

Cheminformatics Tutorials
Chemical Sketching using the Molecular
Editor HTML Reference Guide

Chemical Search HTML, Refrence Guide
Chemical Clustering HTML,
Working with Large Chemical Space HTML,
3D Pharmacophore Search HTML Video
2D Pharmacophore Search HTML Video
How to Create a Markush Structure HTML Video
How to Enumerate a Markush Library HTML Video
How to Decompose a library based on a
Markush Library HTML Video

How to Enumerate a library by reaction HTML Video
Detecting Activity Cliffs HTML
Atomic Property Fields (APF)
APF Superposition, Score, Consensus,
Screening and Clustering. HTML

Ligand Editor Tutorials
Working with the ICM Interactive 3D Ligand
Editor HTML Reference Guide.

Ligand Docking Tutorials
Dock Biotin to the Streptavidin Receptor HTML Video
Re-Dock an Inhibitor to Ricin Crystal
Structure HTML Video
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Covalent Docking HTML Video
Protein-Protein Docking Tutorial
Protein-Protein Docking using FFT Method HTML
Virtual Screening Tutorials
Virtual Ligand Screening to Ricin Receptor HTML
Virtual Ligand Screening to Cyclooxygenase HTML Video-1 |  Video-2
Docking a Markush Library HTML
Induced Fit Docking Tutorials
Multiple Receptor Conformation Ensemble
Docking Example HTML

Explicit Group Docking HTML
QSAR Tutorials
2D FingerPrint QSAR Model HTML
2D 3D Pharmacophore QSAR Model HTML

8.1�Graphics Tutorials

Introduction
The following examples are focused on the structure of the kinase
catalytic domain. The catalytic domain is nestled between the N- and C-
terminal and has high sequence conservation between kinase families. The
adenine moiety of ATP interacts with the hinge region which links the N-
and C-terminals of the catalytic domain. The ATP sugar binding region is
on the "floor" of the pocket where ribose makes a hydrogen bond with a
polar residue. A conserved lysine residue on the beta3 strand is part of
the "roof" of the pocket where the triphosphate group of ATP binds. A
flexible glycine-rich loop moves in and out of the pocket depending on
the ligand bound state of the PK and is regulated to some extent by the
movement in and out of the pocket by the AlphaC helix. A buried region
at the "back" of the pocket is protected by a "gatekeeper residue"
forming a variable hydrophobic cavity. The hydrophobic cavity along with
the DFG motif region are of interest for drug design because it opens up
regions of the pocket which are not conserved and do not bind ATP.

To learn the basics of the graphical user interface we will annotate the
key structural regions of a protein kinase.
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8.1.1�Change Molecule Representation and Color

This tutorial shows you how to:

How to load a PDB structure into ICM.• 
How to change the background color.• 
How to display and undisplay a molecule.• 
How to color ribbon representation.• 
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Step 1: Click on the search tab to load and display the PDB structure
2vz6

Step 2: Change the background color by right clicking on the color
palette.
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Step 3: Display the "a" subunit of the kinase.

Step 4: Use the options in the "Display Tab" to color the ribbon.
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Step 5: Select the beta 3 strand (residues 37:43) and color yellow.

8.1.2�Annotation

This tutorial shows you how to add user defined annotation to a
particular region of a protein structure.
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Step 6: Select the region you wish to annotate and right click on the
selection for options.

8.1.3�Labels

This tutorial is a continuation from the previous tutorials in this
section and shows you how to:

How to select individual residue types.• 
How to propagate a selection from one atom to all.• 
How to use the residue label button.• 
How to make a spherical selection.• 
How to label a residue selection.• 
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Step 7: Use the "Filter Graphical Selection" button to select charged
residues.

Step 8: Propagate selection to all taoms to display all atoms of the
side chain.
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Step 9: Locate the B3 to AlphaC salt bridge (K42- E60) and label using
residue label button. Note: Once you have selected the two residues you
can invert selection (click on invert selection button) and then
undisplay all the other charged residues.

Step 10: Select neighboring residues to the ligand.
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Step 11: Display the residues and label them.

8.1.4�2D and 3D Labels

This tutorial is a continuation from the previous tutorials in this
section and shows you how to:

Create and display a 2D label.• 
Delete and move a 2D label.• 
Create and display a 3D label.• 
Delete and move a 3D label.• 
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Step 12: Create a 2D label using the options in the "labels" tab.

Step 13: Right click on the 2D label to edit or delete it.
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Step 14: Create a 3D label using the options in the "labels" tab.

Step 15: Right click on the 3D label to edit or delete it.
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8.2�Creating Fully Interactive Slides
for PowerPoint and the Web Tutorial

Introduction
A slide enables you you to conveniently store a large number of
different 3D visualization properties (e.g. color, viewpoint,
representation etc...) along with text and window layout. ActiveICM
enables you to view and display ICM graphical slides and animations
interactively inside Windows Microsoft PowerPoint and web browsers such
as Internet Exporler and Mozilla Firefox.

In this example we are going to look at the effect of an agonist binding
to the Beta-2-Adrenergic GPCR (B2AR) and prepare a molecular document. A
prepared ICM file containing three B2AR GPCRs superimposed can be
downloaded here ftp://ftp.molsoft.com/pub/workshop/ (1. cut and paste
the address into a web browser. 2. Right click on GPCR_slides.icb and
choose "Save Link As". 3. Open the .icb in ICM File/Open). The file
contains pdb files 2RH1 (R inactive state), 3P0G (R* active state, with
G-alpha mimic), and 3SN6 (R*G G-protein signalling state). The agonist
ligand causes Helix 5 to shift inwards and Helix 6 to swing outwards.
This agonist binding poses were predicted using ICM a year before the
crystal structures were solved, you can read about this here and a good
review of the structure and function of GPCRs here.

Tutorial
In this tutorial we will build a series of slides and then annotate them
using HTML to create hyperlinks to the slides. The resulting molecular
document can be exported in movie format or in fully interactive 3D
files.

Step 1: Download the example file here
ftp://ftp.molsoft.com/pub/workshop/ (1. cut and paste the address into
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a web browser. 2. Right click on GPCR_slides.icb and choose "Save Link
As". 3. Open the .icb in ICM File/Open). Make a slide by clicking on
the camera button at the bottom of the GUI.

Step 2: The slide is stored in the ICM Workspace panel (left hand side
of the GUI). You can make changes to the 3D display and return to the
display in the slide by clikcing on the slide in the ICM Workspace.
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Step 3: Properies of the slide can be edited by right clicking on the
slide in the ICM workspace.

Step 4: Saving a viewpoint is useful if you are making many slides from
the same viewing position.
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Step 5: In this slide we show that Helix 5 makes an inward shift when
an agonist binds.

Step 6: In this slide we show that upon binding an agonist Ile121
switches its rotameric state and Phe 282 moves.
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Step 7: In this slide we show that agonist binding causes Helix 6 to
swing out.

Step 8: You can export the slides as a movie or you can browse through
them using the arrow buttons.
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Step 9: To build a molecular document you can annotate the slides using
HTML.

Step 10: Edit the document by right clicking on the HTML panel and
choosing Edit.
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Step 11: Hyperlinks can be made to the slide. Other functions such as
adding check boxes, ICM scripts and external links are also available.

Step 12: Save the molecular document in icb format and view in ICM-Pro
or ICM-Browser. You can also export to a web browser or view the fully
interactive slides in Windows Powerpoint using a plugin called
ActiveICM.
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